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System information

Host name:

Operating system:

Edition: Microsoft Windows 7 Professionnel
Version: 6.1.7601

System:

Processors: Intel(R) Core(TM) i7-4330K CPU @ 3.40GHz
035 visible memory: 40300 MB

Display adapters:

NVIDIA GeForce GTX 1030 - driver version 22.21,13.8253 - 4056 MB or mare

NVIDIA GeForce GTX 1060 6GB - driver version 22.21,13.8233 - 4096 ME or more

More information
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Imagery import Operator(s) Job queue Automated Textured 3D
processing model

JPEG | TIFF | RAW BCC MASTER BCC ENGINE

OBJ Import 0OBJ Export '
( THIRD PARTY SOFTWARE <
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ContextCapture Master ALZ At QIE{HI O AUIA S SR HYXILHEZ HAHG= ZRE US)ot
LS HOIHS Hel 882 Z2lot), ol 3D M2 &S & Sl MSELICH SHLE 01 A4 2] ContextCapture
AZXI(AIZ2 IS8 E)0| THE Il 2 &Y 2 X elotLd, ContextCapture Master AtE X+ Q1 E H O A 0l A
AR A OIS KX ZUHE MEESLICLOI AEHHBIOIAMAM HAXILGHY ZHH| MEHQA HHES A E
DUHYEE = ASLICLIAStUHES2 A2 PLIHES Z2X0IMAL. &0 2S5 H £ 3D LE0|
ZHIELICHL

2lE Xl

e ZR NS MAHE3D RS AUHZ 2SS = USLICLIINM LR EH SE I NHMAME
AR L2 EIAMFAZENHUM NS Z MHE 3D 2ol 2t

& AMZ ContextCapture Master AFE AF Q1B H O] A 0f] & & &
BRUAHMECIEHXE D EHU NS2Z (HE S =53D 2
EIAF AZERNE AFZ8t 2IE X0l CHoH XHAIGI 02 & Al 2.
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Windows 8(x64)

Windows Server 2012(x64)
Windows 10(x64)
Windows 8.1(x64)
Windows Server 2016
Windows Server 2019
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2~ 8GB2] RAM Ut NVIDIA £ = AMD Z1chi® JtE, OtLI & X[ 1GBel 8= Ol 22l )t E M & OpenGL 3.2
=

SEIntel S JdciE T2 NAI EREUICH

B Nss &&8ote SE =4 Y2 B £ A GPU R AF0I O =s5UICH ZI A8 F& E2H0IH Ot
U= 4.0GB NVIDIA & X Jt QO OF & LILCH.

OADSUHEMBREIZ2F NS ESLICLZEIDCH E= A0 BE= AESE = AN, §50I

A MotELIC

202091 D&, U8 FE S EME 2d HATS ZFEI AEELICH 64GB RAM, 8+core i9-CPU,
NVIDIA GeForce RTX 2080 Ti 1 & It EE E X & Microsoft Windows 8/10 Professional 648l E & &
HA.CZ2et 2822 24otedd Jl= X 80l 220 Al 2(GeForce TITAN RTX, SSD E¢2t0I1E &).

212 X8 9 @21 GOIEIS )IS X 0% M3 3 7(22% HDD, S5D, SAN) M 3310F BLICL T2l &
D252 1DIDHIE 0142 0IHY IEH IS RS LICL
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A =Se 2 SLICH J2iLE VNC £ = TeamViewer2t 22 & 22| AZEQ U E MEE &= USLICL

Windows NI & & &

%) ContextCapture EngineO| & 81 £| = SOt Windows AFE XIS M EHGHH AFE X AZ S UK LS W
SIERIN IS0l HI2 -5 22 A3 SOl H A0l A IHELICH
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Hl ASCIl = A A= d82 88
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ContextCapture= Ct= GPU Ol [EIH E 0| & &= USLILCH

ContextCapture & & 0f Al "Enable Vulkan API and multi GPU processing" S& 2 M 3AGIA A0l S&2
SEC X S AEIOL D28 LICH.

0l Jlse Chst 33 DXl (Intel 2 Xl 2| 8F NVIDIA, AMD) 2| 021 GPUS AIEE %= JUSLICHL 012 GPUS
MEot=E B0l FelotXIg & GPUR AIEE == USLICL FA HEE MESHH 0] JIsS MESHAIIIE
A ELICH S5 & &l =210/ £ & X & NVIDIA Pascal Ml &l 0] & (GTX 10xx), AMD Polaris(RX 4xx) S
HEESLICL S2t0IHII ZIIHCZ UIOIERSZ S8 Js8HGPU/SC0IH /2 MM =& =52
HAIGHAl & &LICh

20173 98 J| &, ContextCapturetil = H & 1.0.37 01 & 2| Vulkan API% X &3t= GPU E2t0I | Ot

Q8L C}. & B SLI(NVIDIA GPUR) & = Crossfire(AMD GPUR)Z AFE5HAI OHI Al Q. OHXI2 O 2, 0|
SE= MY GPULCIAAE AMIESIER, ARO0| Jts 5L M= EPE 3DSE T2 L=yl
SetRME ZXl OHAAlIL.

OI ZEIGPURE= ZA0IH JI= 2E0I Hloh StE e == UASLICEL 3D M0 Ol 2 A0l S&2

TEHHUHM U S2), UGS HE S HE2HAL.

1. GPUOI %= Z Al E210IH E A XIS Al 2.
2. AREE MHAIHGHYAIR.
3. &It HHS LAl HIESHA AL
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7| ContextCapture Settings @

Configuration | System information

Job gqueue

Define the default job queue directory for Master/Engine.

Job queue directory:

Internet access

Pofiations or 3 i 30 modds an the wep. 1o 7 depla Softuare update
Localization

Language: |English (UnitedStates)

Option

Enable Vulkan API and multiGPU processing (requires compatible OS, driver and GPU)

Benchmark

GPU 1: NVIDIA GeForce GTX 1080 has got the following score for ContextCapture using Vulkan APT: 163.6
GPU 2: NVIDIA GeForce GTX 1060 6GB has got the following score for ContextCapture using Vulkan APL: 96.9

Start benchmark

[ ox L\'\J,[ Cancel

2HEIGPU 2E &= OtHLY:

* 2GPU: 1 GPU CHH| 15% it S
* 3GPU: 1 GPU CHH| 20% it S
* 4 GPU: 1 GPU HH| 24% it S

"VulkanAPI and multiGPU processing” & & 3} Al, Context Capture Engine2 X2l E ?Ioi D222 2 # 52

= GPUE MEELICL Ol SE = AtE6HH, BE =0l M CCEngine2| "--gpu" S8 2 2 VulkanE GPU

sieimes deE ~ UsLiD,
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OpenGLOll & & & GPUIF 2 K& LILCE "--gpu" & & 0

ContextCapture= &4 OpenGLE AIESI2 2, A HILE 2R
1 EH S GPU ContextCaptureJt H & & X| & SLICH

o2 2,
QU= Vulkan GPU 1 E4 Al, OpenGL X 2| £ </ ol
2 CCengine --gpu k
base 20l kKE M &, o & HI 01 A2 ==Xt 101 2t2f VulkanS ?IoH 2 & 3tE GPUOI & S & LICH

% =01 GPUJt 3JH0| 1] Vulkan X 2|0l 1M & 321 M GPUE AtSotdd 10 etCHEH, k=20+2:=52 LICH E &
S Al

/.

0 =

CCEngine --gpu 5
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CtE OlAlL:
CCEngine --gpu 1 (1810 GPU ALE
CCEngine --gpu 2 (2817 GPU ALE
CCengine --gpu 3 1M L 2B GPU AFZ (0] R: 3=20+21)
"gpu" SEE SO LW ITZ )2 Vulkan M 20l I 2422 2= GPUE MEELICH
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ContextCapture 0f| C| &
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ContextCapture Center= 2 AH L2 3D S L IHE M E0IHH, 2| ME S0l Atdl S 2RI Xelg =
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ContextCapture 0| C| & H| 1

s ContextCapture ContextCapture Center
2= O0lI0IX LIOIEHAME 3000(JtE & 0|5t | 2 HIEH
QS HOIE SetREHOIHME 30200 & Ol ot S HIst
NS E=GNETE k- v v
XHE & K 3D X 24(3D TIN) v v
SAEZE v v
AR = Ab AFRL/DSM 44 & (GeoTIFF, JPG..) v v
DYUC TOIE 2242 S M4 (LAS, LAZ POD, PLY, OPC) v v
CAD &5 22 & (0B], FBX, Collada, STL, DGN..) v v
3D GIS & S 2 & & (Agency?9, CityPlanner, Eternix Blaze v v
Terra, Google Earth, Skyline TerraBuilder, SpacEyes3D
Builder, Supermap GIS, DIGINEXT VirtualGEO...)
=4(2D/3D 2 A, 2E)
L= FO/E AA
Jls ContextCapture ContextCapture Center
P H & et v v
X Ol/M 22 H el v v
SDK/Python A& E v v
Jele Z2xE A FE 204 015t S HIEt
M24 Wt Z2A(+=H.) e e
=3 22 v v
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CAD/3D 2T E I

H & Wavefront OBJ, Collada DAE & FBX & &l = AFZ06 2 ContextCaptureOll 4 24 & & 3D 2 & = Bentley
MicroStation, Autodesk 3ds Max, Autodesk AutoCAD, Rhinoceros 3D, Autodesk Maya, Autodesk Mudbox,
Autodesk MeshMixer, MeshLab2 Bl 8t 1R E2/ CADZ 3D RNz LHEE &= JUASLILCH
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ContextCapture= TerraExplorer (Skyline), SpacEyes3D Builder, CityPlanner (Agency9), VirtualGeo
(DIGINEXT), Blaze Terra (Eternix), Supermap GIS, Google Earth, Cesium St 22 0{&{ =2 3D GIS
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http://www.skylineglobe.com/SkylineGlobe/corporate/Default.aspx?
http://www.spaceyes.com/en/products/spaceyes3d-builder.html
http://www.spaceyes.com/en/products/spaceyes3d-builder.html
http://cityplanneronline.com/cityplanner/
http://cityplanneronline.com/cityplanner/
http://www.virtual-geo.com/
http://www.virtual-geo.com/
http://eternix.co.il/
http://eternix.co.il/
http://www.supermap.com/
http://www.google.com/earth/
http://www.google.com/earth/

ContextCapture Master 2t & JHl ContextCapture ViewerS AIEol0] FAEZ L HMOUHM M SES
2telg = JUSUICH E8H0IE ALE6HH 2 S 2 E M6t SUH0IMAZ HLINIOIES M8E =
USLICH

http://www.bentley.comfl M S22 L+ 2 E S == U = ContextCapture Viewer= ContextCapture 3MX &
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e S3CHXMES 222122 3RELICH
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W ContextCapture Master - Internal edition [TestProject.ccm®]

Stephane Nullans .

Eg ContextCapture Center

TestProject
= . Block - Block_15 (Block_8 - AT) Submit Aerotrianguation | | Export |

L Block_1

[ Block_2 (Orlan)
> [ Block 2 (Orlan) - copy General Photos Pointclouds Surveys Additionaldata 3D view
v [ Block_13 (Block_& (200_Qu...

~ Reconstruction_1 @A C [ a——
omplete data
Production_newpacki... P

940 photo(s), 0 control point(s), 0 user tie point(s), georeferenced

) The block is ready for reconstruction.
v Reconstruction_2

® Production_doud Photos positioning level: georeferenced

~ [l Block_15 (Block_8 - AT)

Vv Orthophoto/DSM_2 940 photo(s) in 2 photogroup(s), 18.8 gigapixels
@) Production_ortho... 940 photo(s) in the main component
o Rem;strumun | N 940 known position(s) and 940 known rotation(s)
= 0 control paint(s) (0 full point(s), 0 horizontal paint(s), 0 vertical point(s)) among which 0 check point(s)
@ production_mesh 0 user tie point(s)
35354 automatic tie point(s) View
Reconstruction.5 Resolution ranges from 0.024 meters to 0.027 meters
splats: not available Create

[ (9 &

Reconstruction_1 Orthophoto/DSM_2
ED} 25D ED}

Reconstruction_s

Regular planar grid (grid size 200 meters) Regular planar grid (grid size 200 meters) Regular planar grid (grid size 200 meters)

22tile(s) 22tile(s) 22tile(s)

Review data alignment and create new reconstructions.
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ZZHE =0l A= ContextCapturefil Al XMcl&l= 8 2= 2= CI0IEHE 22 &L

P TestProject < . . .
- Project - TestProject New Block [JIRIstls: Block‘| H
7 Block_1 —_—
. 5 block(s)
L Block_2 (Orlan)
» LoBlock2(Orlan)-c.. | General Options
~ || Block_13 (Block_8 (...
v Reconstruction_1
Production_n... =] =] =] =] =]
~ Reconstruction_2 slock 1 Block_2 (Orlan) Block 2 (Orlan)- copy Block 13 (Block_8 (2... Block_ 15 (Block_8 - AT)
. ) 0 hot;{s‘} 2691 photo(s) 2691 photo(s) 200 photo(s) 940 photo(s)
@ Productio... 0 comsrol onts) 0 control point(s) 0 control point(s) 0 control point(s) 0 control point(s)
v || Block_15 (Block_8 -... 0 user tie Eoint{s‘} 0 user tie point(s) 0 user tie point(s) 0 user tie point(s) 0 user tie point(s)
georeferenced georeferenced georeferenced georeferenced
v Orthophoto/DSM_2
@) Praductin__.
JE11: ZEHE o= 2IEH 0] A
L S o [ — = 1T
DENESNSS IS T YA B2HE SH SEP TEHE SO IO LI,
(=) = T = o =
o UUIEHE SOl Z2RE =5 =5 22Ut
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Import Block“

XML EE=XLS IHE0IA £ IO B E UH=0llA 2 HI & =21 "Import Block"S & & & LI L
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BlocksExchange XML It £= MS Excel I MM &K L= 2F 2 A E N SLIGC

ProjectWise Context Share(il ?IXI&+ MU A S HAEIIHL2HAH, H=UHA FHM == S8 A L.
SSHIIMRIE FRGE A2,

ol 5}

=2

TZNEQ| General HHANE ZZHE JAIEEE ZAGID IZNE 25 S5 22 ELIC

General Options

Block 1 Block_2 (Orlan) Block_2 (Orlan) - copy Block_13 (Block_8 (2... Block_15 (Block_8 - AT)

0 photo(s) 2691 photo(s) 2691 photo(s) 200 photo(s) 940 photo(s)
0 con?rol oint(s) 0 control point(s) 0 control point(s) 0 control point(s) 0 control point(s)
i P ) 0 user tie point(s) 0 user tie point(s) 0 user tie point(s) 0 user tie point(s)
0 user tie point(s)
georeferenced georeferenced georeferenced georeferenced

J&/12: ZZ X E 9 General &

LHAIE =

General BOlA=E T2 HE MEH0| 2 AHAEJEE HEAE = UAsLIT
General Options
@ Empty project
To proceed, you must create a new block or import blocks definition.
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Block_1 Block_1 - AT
297 photo(s) 297 photo(s)
0 control point(s) 0 controlpoin
0 user tie point(s) 0 user { Open
georeferenced  geore
Submit aerotriangulation...
Clone...
Delete
Unload
Open
ES ST CHHOASE EH MHE 20 2elLICh
Clone Block
SEUS SMotH sLetEH22 ZIIE M BT Jtset 258 22 == UASLICL
Delete Block
LIZHENAM EHES HHCHHAH, S A0M tSA LEZ HES 2 0tH U0l A "Delete"E
HEHGHA Al 2.
OlE Soll M L MAS Z8otH 2= 2 2EI=E MAHELICH
NS gYss
S SH TN LS S SR NAS TENE S| AUAE HR0A OIS IHSELICHES 22
T g2 YW BX)
>
= /S
ZZHE Options HE SHUNCEZ H L A E 2e|E 4ol S RES AN LILH
General Options
UNC paths
When usin, e on a computer cluster, Universal Naming Convention (UNC) paths are required for distant acc
and output

ContextCapture

[J warn when a non-UNC path is used (advised when using a computer cluster)

$/DATA/ACUteProje

[ use proxy UNC path for the project file: |//Emeag0132

De Submitt Contex

tCapture '1°I1\—

Associate ProjectWise project |

18 14: Z £ &F E 9/ Options &/
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UNCZE 2
S0l A ContextCaptureE AFEE [ &, T2 HE 2 = A0l & Hel KA AGHH UNC(Universal
Naming Convention) & 2t &2 R & LI Ch.

Warn when a non-UNC path is used (advised when using a computer cluster)

Ol &2 Ct=0il CHoll UNCOt Otel 220t S 2 [ AFE X LB HIOI AN B0 E - 3HeLIC

o IZZHE IIY X
o A I

o A ZECAHeC

o M=ZEHEHL=EHce

Use proxy UNC path for the project file

(LUNCE 2 EZHE MU HOUME AIE |01_‘.:_ ZHAXNUAN EZ2HEI Sl 2R0: 22
ClIHCI0A CCM MY S B 22 UNCIL Ot 220 HHUA MEEH ZAFEH I8 LF I 2

== JASLICL

Olcfst LetEol @F A0S ZAIGH)| 2o ZEAUNCEZE AIEotH ZZ2HEDI Sl AX A SHELZ

ContextCaptureOfl M AFS0l=UNCEZZXE I B2 E & 4= USLICL

%0 &
&1 2 ContextCapture EngineOll A M2l & = U= M=ol OF o= CI2H el | & LICH

Olsds S ZZ2HES Y S LAHUE +=Z3E = USLICL M Z2HES MA A [ Hel=
ContextCapture Settings(& Xl ¥ 724 A& FR)MAM XNEE JIEH22 =I|3tE L EP

ProjectWise T2 & E
ContextCapture = 2 & E J} ProjectWise Z2 M Ef| A& 2 4= USLICL

| Associate ProjectWise project | |y = = 1 €8 51 04 Project Chooser (314 VE 271 DS 018 I}
SHBIAAID. 03] LES AIS510] I2HME 2MS X351 A,

oIr
ro
|5
Hu
12
Im
1

B ProjectWise Project Choaser [m} *

+ Register Project O Refresh View : ! * Favorites \ @ Recent |

Select a project &

Number Name Location Industry Asset Type

Prod Test 20121125 EA Prod Test 20121125 EA Buildings and Facilities Airports

001-Dec PWDM 101 Southbank Communications Telecormmunications
12012016 Vilnius proj 5 12012016 Vilnius proj 5 Buildings and Facilities Airports
OPModeler_Imperial Bentley Pune Pune India Other Other
11.25.2015.8.1.1 Windows 8.1 x64 - M5 10.0 Exton Buildings and Facilities Airports

Associate Cancel

_7&/ 15: ProjectWise project chooser
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AN HZE ProjectWise ZZME S MB35t 1] "Associate" HES FEH AN L. HZEH, S HS2 B
T2 M E A2 0| ProjectWise ZZ2H EOff 2 Z & LI Ch
y n
& 2el At
clAAS &0lot) @38 S76H)LE S0l EELICH
ContextCapture T2 M E = £ (|2 L LS AN B OIAT L2 0H AR 2IAAE ZFXELICL
Reference manager 2/ HHOIAS AIEctH ol Y A E &0, =21 £= HUOIEE += ASLICHL
LR LAAE SetRES} SII8He = USLICH Reference manager CHSH A XHE AFZ6HY SII3HE &0215HD
Mg &= AsLIC
W Reference manager — [m] x
Reference manager
Check resources, repair or update links.
Filter: filter paths P Update status
Update status and retrieve cloud
Type Local Status # Local Path Cloud Location  Cloud Status properties
= Image Collection Unknown Dy TESTS/ Tuxford_Scan+photos_Light/Photos 5 PWCS Q
Clean database
Removed locally unused entries
Replace in paths...
Apply changes in file paths.
Apply changes  Cancel changes Close
_7&/ 16: Reference manager 2! E{ ] 0] £
SO HEN 2ELX 22 S50 LA U= B3R X 2elte B2 HE HXE HEo| 226t
ST N 222 UAHOZ 2EBLICHES 2C/012C &X)
Update statusE Soll 2l 2 A AEHE &I LICt Replace in paths T E MEStHU elAA FEZ2E M F
HEOIH dIE =-+otHL SHOIESLICH
HZAFBIS 2l AA HIOIZ0IA 2R 2H EAISI 0 Apply changesS 2215t Z 2018t A2 =S LICH
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CIAL HOIES Z2EHEELICH
ZHE MEStH e AXN0A 2l AAS HEN S = USLICHL
ZH = 2tete AL EIE UXI(?, * S)E A2 ELIC
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il Replace in paths
Replace in paths

Make changes in file paths.

Find what:

Replace with:

Look in:

[All items -

Find options
[7] Match caze
|:| Lse regular expression

[Replace All ][ Cancel l

_7&/17: Replace in path [f 2} &/ A}: Find what 0l 6} F &/ EZ 2/ & 5/ 1] Replace with 0l A &/ A EEZ &/ &8t/ LF

"Find what"0fl Bt =2 & A EE 2 & 3t1) "Replace with"0fl Ml A E S & 8HLICH

0
x
]2
|0
HU
o
+
=
i

Lookin: @M 2E 212 2= &S0l Bt RIS HE6tAH All itemsE & &6
Xl Stoted & Selected itemS 1 &4 8} LIC.

Find options: 105 HtRJ| A S =35t ™ Match case £ = Use regular expression= &4 3t & LI Ch.
claA gl 2te|

o/

Ty
S
0

A @F

Copy path to clipboard...

Open...
Details...

STERTS/Rarmettec/harmettes nenrefPror

J8/18: 2| A A ZEAE [ 77

AHZ B2 2010 S LIC

A HLZME Sg40l Oetd2 HBAES A3ot= U Al2H0l B0l 28 == ASLICHL
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HIOIAY 2| t= Z2HE 3D FUAM HANAS == U= HIOIAY 00 E 22lotes O ArZE LICH
HIOIAYES Z2HMEZD UM AHAE E=H X HOIHZ AAEE = XIS S2HGI0IEHS 3D E& LICHL
CXE g 290 g4 &#X 0101K2 24 ELICH

HIOIAYS FOtoteiH T2 MNES & #AGH0F &LICHL

ContextCapture= Bentley2| GeoCoordination ServicesOl M H&E Ch22E8 HA L 001X HIOIH £= 2

9o 91 0/0IX THYOIA HIOIAHS MAE 2 ASLIC

Bentley GeoCoordination Services & &

GeoCoordination Services= T2 M E AA M AFZ2 JISSHUIOIHE &

=
CIOIE 18l MHIAJLICE O EH0A AFE Jls&tOI0Ie SS2 REotL)
HEiE = ASLICH

roh

GeoCoordination Services= 0| =, JHLICHH| CHSF GIOIEHE HISHELICHL E&Z2 HEWM=H Z2 S DHECE
Ol & I LICH

GeoCoordination Servicesi= Bentley CONNECT A& KHOIl H O 2F = A HI A ILICH AHE6ted & Bentley CONNECT
Edition2 =2 2 1910l OF & LICt.

& 1: GeoCoordination Services URLEZ ContextCapture S& 0l A HE S = UASLICLII2EHL =2
"https://connect-contextservices.bentley.com/v2.3/Repositories/IndexECPlugin--Server/" It At& & L| Ct.

Basemap managerS 228 (22 S8 8HLI L},

e Project 0l 7 0ll Al: Basemap manager & &4
o =SZ3DF L= MA3DRUAM: Layers HES S A4
e 201012 Ofl 7= Ol M Basemap manager 1 &4

Basemap

» Basemap_Dam

£ 3D 7 A0l Oil 5 0ll M Basemap managerE & LI C.
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o’ Basemap manager

Basemap manager
Meanage project basemaps.

Name - Description
Basernap 11

Glebe

Basernap 20

iBasemap 21
Basemap 22

Propertes

Basemap 21
Bazemap ID: Bazemap 21
More detals

=k add...
3 Delete

Close

Basemap manager &

M HIOI AR S =Jtote{ ™, Basemap manager & 0l A AddE 26t 3D F 0l A=l 01012 Bl 7= 0l A Add

basemapsS & & M ELELICL
Name
HIOI A el A

FIOr HIOIA YOl Coll & S0t= 01 S

o
e
J
o9
c
o
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¢ Add basemap » IEM|
Add basemap

Add basemap using Benlley GeoCoordination Services.

Mame Name

I
Region of interest Enter basemap name and description.

Data selection 1D Basemap_23
Neme |Besemep 23
Desorption

<Back || ©)Next Cancel
HI Ol A2 =Jt: Name H| O] X|

Lt = 0ll Basemap manager LHaH & XHOIA OIS HE S =& USLICH

Region of interest
1 EHELIC}. Region of interest= GeoCoordination ServicesOl Al Il OIE1 S

HES HIOIAYS BI2E AIIE S HEHE
QoL LA BH HOIHE 28 dF52=2 A== U AHSSLICH
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4 Add basemap

Add basemap
Add basemap using Bentley GeoCoordination Services.

Name Region of interest
|I Region of interest Enter the geographic extent
Data selection Bourding rect:
X (meters) min |461582. 540921 max 463411, 770520
¥ (meters) min | 3155814575770 max | 3158182,561552

182G, 229590 meters X Z367.985782 metars

Spatial reference system: | WGS 84 [UTM rone 17N (EPSG:32617)

Import from kML,

Restors default bounds

JIEMEAXI A=
2dgLICLoIE 3

Data selection

=

HIOIA = K &ots Ol AAS 5 = UI0IH S5= dHELICH UI0IB == 0= GeoCoordination Services Jt
o

KNEE 208 SAUM &2 S2H 010t ZEE 0 ASLICHOLH OI0I Xl & X).

[u
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Add basemap
Add basemap using Bentley GeoCoordination Services.

Hame Data selection
Select layers from avallable data. Data will be downloaded from remote servers then imported, operation time will

depend on the quantity and size of the data.
(e |
Momber of fles Resolution {m) Diate 0

Layer
[+#] FSA 10: 1 NAIP Imagery m_2808. . : 2file(s) 1.0x1.0 1812/2013 01:00 42 MB
[] USGS High Resolution Orthom.. B ile(s) 0.1500:0.1500  01/12/2011 0:00 781 MB

<

Terai

Mumber offles  Resolubon (m) Date Sze
27.1291x3087  01/07/201201:00 37 ME
01/01/20M3 000 316 MB

Layer
USGS NED n20w082 1arc-seco... 1 file(s)
[ USGS NED nZ9w0B2 13 arc-sec., 1 1file(s) 9.043x10.29

Hil O A 28

SESEHOIE 2 JHRE 221 ™ More details=
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- ContextCapiure Master [ |

Selected dataset details

Source Tawm of usa ire Proview
JSG5 KED n29w087 1 afe-secand 2017 1 x 1 degree 4G Y 17 B Lk

FSA 1071 NATR Imsgery m_JR08129 g 17_| 20111025 J01NI205 175 w B 75 mnute JPEG 2000 Som The Natoral Map ik Il e Mot 3 vaiahis
FZA 10: L NATR Imasgery m_2808 100 _sw_17_1_21XI0LI_ 20101205 3. 75 x 1. 7 mmgte PEG2000 fom The Mabonal Mo unk 1 . Mok gvaiable

_7&/. Selected dataset details

Aot s =g == AsUIth

o YOI HRX IS AN AT SE& IEAH I U= HAE DTM: GeoTiff, IMG, ASC.

o Ol0IXNIS ER:Cis &AM 2ed SSE ZEAH I U= 0101 Xl WHY: GeoTiff, JPEG2000, JPG, ECW.
sS4
2 A 2 UoIH ANOI=e: 2dstE): Hgdatold detst 2= 23 OI0I1EH It S AIELICH
LB IO st =0l FX0IS2g: B of=D): 23 A WA Het =0 EEXE S ELICL RS
A MY EANTHS IILILZ oK =0IE0tH2 [ BYE &4 = YIS 200 WGS84 EHRIXI D1 gt
A MLS A2 XS AEELIC
HOIAWS MH5t= U AHEE IO === & & 5t] Download and importE 26t H &g LICH

212 MU0 A GIOIEIS CH2 2 S6H0] IS CH2 SBH2IE /513D Yo

ContextCapture= Z R &t & S
A A2 U0 210 D101 Chet et LT

o
ZEOHAIE MlELICL &S
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&/ GeoCoordination Services [0/ E O A1 84 & & H 0] A /2 0

A3 22HEI2|

Ol EFE AMESoIH ZZ2HE A LS ZelotH OA3 S2US EAE = ASLIT

IZHME SF(EZZHECAE U OIRA LEXE HES 21 "Free up disk space"E A EGHH & el
A XIS & AI2(Ote OI0IXI &), BelohOF 5h= Al THY JtEI D el E M 35t "Delete files"S
HEGHY AR

ﬁ Free up disk space

Free up disk space

" You can delete cache files from your project to free up disk
space.

Files to delete:

Image previews
Aerotriangulation temporary files
Reconstruction temporary files

0 folder(s) to delete & pelete files
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AME L HE SELAME D8 S4: 44 30, =8 Hel, 8, d X H3/EX: X, 2 &) L HEH ZOIE
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e MNMUEIEHHES HEH2Z 50610 S50l AHA S =8t TS ContextCapture2| &3 &2 SEHS
AESHH 2280t HEE A 8 Sd L AN ZXE FHELICH

o XMLINZOUAM 286tD &t AN D8 58 R MY ZXJF 2 E AN S JFESLICHO: EFAF &2
A SHATEYONUHA). == IHHLIE FEoY AL

see

Block - Block_15 (Block_8 - AT

Submit Aerotriangulation | New Reconstruction ‘ Export | <
4] a 4

General Photos Pointclouds Surveys Additionaldata 3D view

contral point(s), 0 user tie point(s;

@3 Complete data

The block is ready for reconstruction.

Photos positioning level: georeferenced

940 photo(s) in 2 photogroup(s). 18.8 gigapixels

940 photo(s) in the main component

940 known position(s) and 940 known rotation(s)

0 control point(s) (0 full point(s), 0 horizontal point(s), 0 vertical point(s)) among which 0 check point(s)
0 user tie point({s)

35354 automatic tie point(s) View

Resolution ranges from 0.024 meters to 0.027 meters

Splats: not available Create

[ [ (-9 ~
Reconstruction_1 Orthophoto/DSM_2 Reconstruction_5
3D 2.5D 3D

Regular planar grid (grid size 200 meters) Regular planar grid (grid size 200 meters) Regular planar grid (grid size 200 meters)
22 tile(s) 22 tile{s) 22 tile(s) v

1819: & &= 9/EH K0/ £

e o
o [T
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o In
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g O
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Imi
I
o
2 I q
= |
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N
>

Control Points: =S 2

¢ Tie points: ContextCaptur
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o Import blocks : XML I+ Off

o Exportblock: CtZ&H I HAOCZ SHS UHEY &= JUSLITH

o Splitblock: 2 && SHE W F222 Lz UICH

o Extractblock: S UM AS FE&LIL

e Load/unload blocks: & ZZ2HMEWAN 22 2E/AZEFLIC
e Mergeblocks: MEHE EHS 6HLISI M S22 HESHLICH

e Share on ProjectWise ContextShare: ProjectWise ContextShareMl Al O|O| K|, A 24, Bt&F S M &=S
28 8HLICH

S=HUA 58 =2 S5 2 Block Item View2| &1t BIL 0l Al 01 E Jts & LICHOte OI0I Xl & X).
X

ANEN= S 42 S ME ME2 MAEBD 0, BAFAIRY S) FIL =8 WEUWI| & S=otJl, 29

24
£ g =+ UsLIth

Block - Block_15 (Block_8 - AT) [ Submit Aerotriangulalionj ‘ | Expon‘| <

A M =Xl Submit Aerotriangulation2 2 & 6t™, ContextCapture Engine £ = 222 E0M 22 2 el & &k
FTEeTHE MU OAESE Y/T= MR ZXIFEEE M E3 M2 D AIRELICHZE2ARXE UM Hel #X).
S0 24 &S AL SO HAMHASA= ME2 HAS MHE 4= ASLICHL N2 M4 L 2t2] 0 2taH
O KtAIEH At 2 A S E RO AIL.

ol b}

=

E2 09| General 1S S ES HAIEE} ES HH S ES 2el&LICL
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HAIE =

General Photos Pointclouds Surveys Additionaldata 3D view

Complete data
The block is ready for reconstruction.

Photos positioning level: georeferenced

940 photo(s) in 2 photogroup(s), 18.8 gigapixels

940 photo(s) in the main component

940 known position(s) and 940 known rotation(s)

0 control point(s) (0 full point(s), 0 horizontal point(s), 0 vertical point(s)) among which 0 check point(s)
0 user tie point(s)

35354 automatic tie point(s) View

Resolution ranges from 0.024 meters to 0.027 meters

Splats: not available Create

12/20: £&/9 General & A/ 2=

L Y o ~
Reconstruction_1 Orthophoto/DSM_2 Reconstruction_S
3D 25D 3D
Regular planar grid (grid size 200 lanar grid (grid size 200 meters) Regular planar grid (grid size 200 meters)
22 tile(s) 22tile(s) 22 tile(s)

new reconstructions.
M2 OLOI 20 DISAE UL QLEZHES +28 M2A =0 2ol S S&0| MAIELICHL
L

- Open: Reconstruction Item ViewS & L|Ct
Clone: & IS SXE ddeLIth
- Delete: &5 THA S M A S LICH

Photos

Photos &2 A&l HNIE & A2t 54 = 2telote Ol AASELICL

“an

S0: S50 H20l ottt = el H 2T A2SH Photos B2 S| &= LICH

CE—Ta |
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General Photos Pointclouds Surveys Additionaldata 3D view

Important notice on photogroups: For optimal precision and performance, please check that your input data fulfill these conditions.
v - HH = L 8l Check image files...

Photogroup Status No. of photos Main compon Camera Sensorsize  Focallength  35mm

Photogroup 1 ) 267 photo{s) 267/267 ph... DJI FC6310 13.2mm 8797609 mm 23993 Name
Photogroup2 (@ 673 photo(s) 673/673 ph... DJI FC6310 132mm 8.81842mm  24.050 Directory l:l

T \:’
Multi-camera rig
[ Camera
Photo Pose Pose metadata Component

Camera model type

940 photo(s), 2 photogroup(s). 18.8 gigapixels

7&/21: £&/ 9/ Photos &

AHEL =0t

5122 M58 HHAE MTE 0121 48 TE22 Lisl0r BLICL 48 252 SUL Liw (01011 1,
MM 3|, EF el S)2 ARSI SUE 22/ M2 BHE SHO| AR MEALICHL AR 20|
M%%mwawm+a%uaaawi%gmmommmmmmmwmuaMmjigm oz
23+ AU

et AR IH SAIS B ETHIAIR.

OIOIXI LIOIHMES 3J1= HCIE0 Tet MetE = UASLICL AZEAN HCIES S0t A L.
"JE Add photos. .. E| 'ﬁ Add photo selection...

MHEE AR T2 EIHEIIC

MES W i HEGH B Shift L= Crl 9|1 E ArE & LICH

I8 E FIIELICH =8 O R 2 9 &

& Efet Ol ROIE2D XA = A2 0l 20l [= 2= ALY S FOtE LI
2 A I SEAS HXROYAIL.

ﬂ Import videos...

0L A ZE&E F=o/0f ES 0 FIteL/LF
HC THAINHLIE &FX
[‘ﬂ Remaove phutos]

HOIE A & EEt AFX SEE AN IEE M ELICH
Ol O HERGHe & Shift £ = Ctrl 91 € AFE & LICH
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ContextCapture I+ 0l 2t Ol Ol E{ B0l A E ArE3H ContextCapturel A AtS2=2 FHE == JUSLICH
NS = JUSLICHESHS OtH S W, StHict CIOTEHIOI AN A E£= OPT I 0l A).
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£ ot= HZ RGB IOl 2t LICH
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A 301

ContextCapture= Jt0ilct Ml A2 3II1E LOLOF ELICH 28t &4 ZJ/= A2 e 2 X +=LICH
CIOIEA Bl OI A0l ALS XFE2] D102t 220 Ot LHE SO /UK H 2B 0l 32 E L HolOF ELICE S0 ctHe
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LIS 0ll ContextCapture= &3 &2 SO 2 B HEolH FEHE N2 FEE = ASLIT
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MZ M E AR DE2 B ContextCapture= JI 22X Z 2l X =0| QACHD 2HF=8HLICH LIS 0l
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togroup  Status Mo. of photos Main compon Camera & Sensor size
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roup 2 — — -

i 3 g] Add camera model to the dat

jroup i - :

Jroup 4 @;‘. Import optical properties...

Jroup 5 ,-é}, Export optical properties...

yjoup6 (@

Jroup 7 & Ungroup

jroup & @ 200 Set pose from metadata

jroup 8 @ Clear pose

Set metadata from pose

Clear pose metadata

Set mask...
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2S5 LICH ModifyE 2ot X 20 =0t AFYO0 et GPS L E#XEE HIEY = AsLIL (=% £=
WGS 84 EFR ).
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‘all Import positions...

EIAE DI WA AFA SIX £ o & It 2T/
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Metel &= JbXl &2l 2 ©: Check image file header only (faster) 2/ Load the entire image file (slower).
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it ot chouds e Bugecioren. oirimred use & bl scarer

gt fim. Input files

T p— Define the nput poant cleud and tragectary fies.
Trajpectorses snd point choads sre inked Shanks bo e stamps. i both sets of Sles.

Praret Gt

R ot ...
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LIRACOGES 1o 1 4040510

LIMOGES6. 180403, 159010ns ]

A baeciores.
LIACGES 6160805, 15510 3

LIAOGES16 60805 150 0Em
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E24: DHIE AZHOIA EOIE ZRE IIF 2T/
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e Number of lines to ignore at the beginning of the file: It 2 6l 20/ & & 2lot ) It ML= S92F
S AlIELICh
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HMHE2 =522 FIIotHL 2 A2 M IMEE = UASLICL AU E T2 E EX6HYAIL.

ALE

S0 MOES =)ot st & HXIt Jtsotd FHel AE Q=S SAE = UASLICHL

HOE MEE= 3042 HMOHE22 A& 10 2128 204 0142 0I0IXI =& 80| Y= &
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ESUOZ AIS SE = AsLICH

Mo =0t
1. Add Survey PointE

+ Add Survey Point
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Name: |Control Point L
Enter known 30 coordinates of one point

Type: | Control Point * | located on photos. Used to register the
3D scene.

Coordinate:

WG5S 84 >

Longitude: Latitude:

Height:

A\ Flease enter 30 coordinates. Create | Cancel |

&+ X+2| Typelil Al "Control Point"E & 4 &HL| C}.

Survey Point i &
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o SHINNMJIIAZ: HOUHE2 2 F LR = ASLILLESH MRS FXoYAL.
o Surveys & (Import HE)HM It 2 MOHE BIAE T ALS
K& &= &84 2 TXT/CSV & ContextCapture Surveys(XML) & LI Ct.
NG = MO I J2 e XYZ HEI) 3oz 22& MO E 3D XS UZote &E TXT
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HOE EAE 1 ME:
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IR OHHAIS SoH ST 22 D2 M2 TS50 22N A2 2D EH AEX Ho eAE
HASIIHE 2 USLICH
HOIES IS I SHIZ 22+ &2 X AIASI(SRS)S MEM=X| SOIGIHAAIQ(22F &2 X A AE &X)

ContextCapture 62 AEXF 0/ =



by Google Eath

i ¥ Seaich

» Ligux

_agmtmnm;mmwnm

|  ewerple: Motk & prosmite de Fac

Itinéraire Hstorgue

* Cal Galerie Google Larth 30

i

Lat 43 8248" Lon 2 41453"
Ellipsoid height 94 2645 m
49 measurement(s)

Mirraine | VBIs cB By - A

i

HOE &4

I
0x

HO&E £80l HAASHA S Edit

ContextCapture

&/ 30: Google Earth 0| A1 2] & X/

i
iy
it
il
c
o

(<] o

Name:
9001

Type:
Control Point -

Coordinate:
WGS 84 w7

Longitude: 6.33589498
Latitude:  456.65644157

Height:  573.32500000

Check Point: [

Category:
Full -

Horizontal accuracy:  0.01000000

Vertical accuracy: 0.01000000
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o WGS84: 9T AT(T), EF A =0/ (0IE).
e Other: OIH S22 X Y =O0|(HEE HEH O [HS).

Check point
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o Full: XYZ B EJ} AFESLICHDI 23,
e Horizontal: X ¥ Y R E Ot At E LILCH
e Vertical: Z R HE 0t AFES & LICH
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HAHEAX L YXEN ol =HE BT E LS LICH
FECIH =2 MUHEB0l 23 42U SHUA O X2 HSIE 24 ELICHL
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Identify one point on photos. Used to
* | create positioning/scaling constraint, or
Create

to stitch photos.
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= Add Survey Point
Survey Point
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1. Add Survey PointE 22
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3. Type Tie Point
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= Add Constraint

® Onentation Constraing >
% Onign Constraint Fi
% Scale Consiraink Fa

1&/32: AX AE Het X2 F=9 0

HE HEtxA
Add constraint type > Origin constraint
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SERELICH
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Add constraint type > Scale constraint

S AL BE 8ot & & AMOI2 el E N E L Ch

YD JA= B Hel SR E HEst, S0 2 & X 22 & 2 "units (arbitrary)"E AtE & LICH.
el A MEt £2HE FIOHE = UASUCHL

= M8 X

Add constraint type > Axis constraint Orientation = J| 8t XISt 224 2/ L|C}.

SISl BAX B2 = &t O, 01 50| 2 ABH (AWM BZ gt SIH= &= LIC
MOE Y HE ZH0l EMole ZR(E L= B ME ZH) S HS 242 FOHE = sLIT
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Add constraint type > Plane constraint Orientation

&o I/ B Alat 222U
HHS XNHOHAH Z AN IS =5 S OHE S &LICH
AL OE YS e ZAH0| EMole dR(=E L= EHMS ZH)EH HE ZHE FOHE
=
S 2D
Export HES 2E/0t0 S22 (st Y A2 LHEYLICH
4 Export surveys - o IEN
“  Export surveys
Export control points, tie points and constraints.
Output file and format
Format:  ContextCapture surveys file (*.anl) -
Fila: |_quarry_switzerland/mining quarnry/Block 50pc - Surveys.xml '
Options
v| Control points
Tie points
patial reference system al East-MNol ongin: 4&.6544
Constraints
© export | | cancel

_J&!33: Export Surveys [} 8} &/ X}

KML I} &

o EEE HAHE £= 8 & & (ContextCapturel A 3D X E FHE = U

= ASLICHL Jef8 0l Y S AHESHH ol & B2 E& GIS =+ &£ = Google
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eweenpie Witels & prosamite de [st
Itnéraime  HEtongue

Lat 48 B248° Lon 2 41483°
Ellipsoid height 94 Z846 m
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BIAE IIY
MO & £= 8 &8 (ContextCapturell A 3D RIXE FEE = U= ZR)20 U HEXK Y, Z)It Z&E e
EAEIIYZ HEY = ASLICHL
=SS HAE I ME:
GCP_A 315796.627695945 4869916.09237971 627.8
GCP_B 315332.029686681 4870703.80261219 738.9
ContextCapture =& I} 2 (XML)
SESZUOIHEHEE 54, MUY X £ AX XNE Mt =2H Ze)eE XML EACZ WEL &= JASLICH
ZH Y HEAEF
ContextCapture= SHES HH ESE A= 0HH &EHC EH L= 8L, HAl 8IE S= MS&LICHL
Photo's filter
Olefst SEES ALZotH AR =S50 2EHE =2 = JSLICH
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Ol 2EHE A EotH dEist SSEEN CHst oS &EHO et AFRI S 88 E = ASLICH
Al M InUse |
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D= MEES EAIELICH
SEHSH SSFE CHS AEH0 et 2HE 2 B2 SHELICH
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Aerotriangulation definition

Define parameters and submit aerotriangulation processing.

Output block name l Output block name
Compaonents Choose the name and the description of the aerotriangulation output block.
Positioning/georefere... ID: Block_28
Name |Block_1- AT - A
Settings = T

Description | gagyt of aerotriangulation of Block_1 - AT (2021-5ep-30 15:29:11)

< Back £ Next Submit Cancel
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e Useallphotos: &3 &2t S22 =2 PHRQLAN SoHA E= MES ZSELICHLESHN M2 FIHE =2
TERAAKOIL Ol &2 &2 S0 2ol MAE AFX Ol S&ots Ol = = ASUIC

o Use only photos of the main component: T2 LA 222 AR &3 &2 SN 2AIELICH
Ol8ol &8 &2 SSH0AM OHXIE AL MEO CHol MZ H&tet RE S ot 0 K8 &= ASLIC
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Aerotriangulation definition

Define parameters and submit aerotriangulation processing.

Output block name Components

’C“'“I"Tl Select photos to consider for the aerotriangulation according to their component.
Positioning/gecrefere.., Not all the photos belong to the main component.
Settings Photo selection

® Use all photos
Include photos not belonging to the main component in the aerotriangulation.

(O Use only photos of the main component.
1 photo(s) wil be ignored by the aerotriangulation.

< Back € Next

Submit

Cancel
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Aerotriangulation definition

Define parameters and submit aerotriangulation
processing.

Output block name Positioning/georeferencing

Positioning/georef... Choose how the aerotriangulation should adjust and orient the block.

Settings Adjustment constraints

Control points
[ photo positioning metadata

Point clouds (scans)

Einal rigid registration

() Positioning constraints on user tie points
O Control points
® Photo positioning metadata

Point clouds (scans)

Custom Advanced...
[ Use targets (QR Codes, AprilTags or ChiliTags)

Using selected data for adjustment (1) and for rigid registration (2}
The block is first adjusted to selected data (Adjustment constraints) and then rigidly
registered to selected data (Final rigid registration).

<Back||@Next | | Camcel|

gs == 540 Oet ?IX NE 220 2deE LIt
SE 424 S0 AXN XNE Mot ZAL2 A5g += AKX 0 B2 =4 2Kt L2 S2AF[L LT

Adjustment constraints:

e Control points(R 28t HIHE NE ER): S22 MHEN XE==E ot ZFELOHAHE 2L &0t
LA At LXE I HEE

» Photo positioning metadata(2 & S 0ll /I Xl XIE HIELCIOIE I A[= AN 01 3E Ol e ER0UE 01E
ts): E42 ZX HEHIOIE 2 AbE 2IXI0ff et &6t ZEELICHZ =E HEHIoOIE ol 2 E ).

¢ Point clouds (scans).

Final rigid registration:

 Positioning constraints on user tie points(2/ & =2 0fl ¥/ X| XI & H s =
o

g2 0lel ZoE Met 20 Wet DECZ BIXI/SE T /AHNY =FELICH
+ Photo positioning metadata(2 & S0l 21Xl XI&E HECIOIE It U= MO0 A 3E A= ZR0ME0I=
ts): 282 ZX HEHIOIHS ALK 2IXI0 et DE =2 SSELICHE 6K &2 HIEHHIOlE o

).

e Control points(F &8t MHE ME ER): E42 el 84 H=S MalotAl XD HAHEN DE22
SEELILH(E SN &2 MoE 2 EED.

e Point clouds (scans)

-
-
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e Custom: ==0| 105 Hataf Xt THrer BIEHCIOIEH E JIt 22 ot DE 22 BIXIE 1, et 2 AH O
LZE UL

tput block name Positioning/georeferencing
m Choose how the aerotriangulation should adjust and orient the block.
ettings Adjustment constraints

Control points

Rigid registration

Position: | control points v |
Orientation: | Position metadata v |
Scale: | User constraints v |

Point clouds (scans)

@ Custom (ControlPoints | PositioniMetadata | UserConstraints) | Advanced...

[ Use targets (QR Codes, AprilTags or ChiliTags)

Use targets (QR Codes, AprilTags or ChiliTags)
AMEOA =Se HA0AM X XE ME XA L= HOHEE AE0tH =2 SSE2€ = USLILLEN =
OOIE &= AtEELICH
CHAH A A0l CHO XHAISI 2 O0FE2 J|: ContextCapture Target Creator.

HOES AR NY 2E0 B2, XS SES DRI H HAS AT SEE MOE ME =, 2%
S 01449 ZJ 0/ A= F 4 M WS FOIF0| B LELICH
£
NS EZ YYD AT ST HEELIC
89 A IH01E

ContextCapture



Poses and tie points

ZX HEEU ALS

e Compute: 8t 3 &2
. Adjust'

ContextCapture

o=

S (=}
0 AFDH
[=) =

(=]
Ab
(==}

ﬁ Aerotriangulation definition — O X

Aerotriangulation definition

Define parameters and submit aerotriangulation

processing.
Output block name Settings | = | =] |
Components Choose aerotriangulation settings.

Positioning/georef...

Poses and tie points
Settings —
® Compute Adjust O Extend Lock Advanced...

Computing poses and tiepoints.
Parameters: normal keypoints density, default pairs selection mode.

Optical parameters
® Adjust main parameters O Lock all parameters Advanced...

Adjusting focal length, principal point, radial distortion and tangential
distortion.
Keeping aspect ratio and skew unchanged.

Targets extraction: None ~

Automatic color correction: Blockwise ~

Create splats: (:)

« Eack| [ |@Submit | ‘ Cancel |

TE42: §2 H42

[=Ray==i]

Jy
N
1y

=235t i.” @ Et% A EHSH L| E},

-

90

2P SE0AM JlE A& IJHJH HE MESIH ZE FEES HLEL
SEO0IA Jl= H & OHOH & & &
2 = 01|/\-I DIEﬁIMUHJH

AFEXF IH01 =



Poses and tie points

Policies
Paosition: | Compute v |
Rotation: | Compute hd |
Tie points: | Compute v |

Computation parameters

Keypoints density: | Mormal v |

Pair selection mode: | Default v |

tsetOIoIE 0l et O E =3 sS40l (et =8 3= d8E = AsLIChL

J
SID AL ST S 0 SH HE IsE =E S&

. Compute: 42 XS ARSI 21 FHBLICH
. Adjust U2 FHIE W50 ZHSUCHENE $40| D2t RRTE 26| st FIH S6S
RIoret & US)

 Adjust within tolerance: AFE Xt 2| SXNHAI & FEX0 HZH RASHHAM & =HXIE ZEHN
FZHELICHL
o Keep: 23 =HXIE JDUHZ AHEELICH

Keypoints density

SHUOOIHMEEZ 2clot)| flol I EQE L& gts HEE &= UASLICH

e Normal: HEZ2| O|0IXl CIOIEH AN E0I & & E LICH

o High: IIAIMI Sl A YO S26HAI REHLEAROI 22 R U IERIESE = U B2 M S I XIcts
HOIESLILL O 23S AISotE &3 oA =& Xel St =L

HM Normal 2EEE AN A AEELICL

Pair selection mode

CE MBS INCISS MEoIH E&td A= HoE = USLICH

o Default: 882 Z Xl J|&, 1 = 0I0|X| 2t SAIE S J|Ete 2 &
aas

=HELUCLCLOI0IXN At 0l &

ol AIEH B2

AL

|
o Similar images only: 9| 91 E R ALS 0l
SelHol At A2 ZE2 ZHE N
. Exhaustlve' A& 2+ QH 0| HIstEl
$). BN e A A2 2R H EHAHO

%‘Ll Ct.
o Sequence: XIZE el LS QI E MOt AtE & LICH Default 2E0F A THE 22 HY ALK AIRAE
Xelots A0l ESLICL ME Y =A=E AIEA =M 2 2 XIoH0F & LICH

|
| &L= 2= Jtset &= AASELICHO: Jtollct ZBl2]
SAXEC=E 2XH) B2 =2 AFEI(==28 JH) 0l 0l 2ol OF
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i

F Default 2E 0 A TIHSH H R, &Y AR 22X

& X| ot OF & LICH.

—
o
o
o}
4
=
10
-
03
il
e
o
=
(Falye
0
= [r
e
o
0=
e
=
0t
il
E
2 O

Optical parameters
OO == =0 AISE & defs &8 gLt

[S= ] — T o

Advanced HE = AIE0tHE RE = A& F 2 S 0 B2 0N 28 &= AsLICL

Optical parameters

Enable pre-calibration stage: C)

Focal length: | Adjust v |
Principal point: | Adjust v |
Radial distortion: | Adjust v |
Tangential distortion: | Adjust v |
Aspect ratio: | Keep v |
Skew: | Keep v |

Pre-calibration stage

Pre-calibration stage= Z=J| OHJH B ==Jt &Kl 2t (0l: & == 8l= =& Hel &= OE* o= S*AE 2 H=)u HHeldt
2| H20 &2 &2 S0l %HH%% i #=&LIthol 2=

2EHITUOIHMEZ =& ALA0 4= H 20 &

v
ron

té*@OI **2 LI Ch

Target extraction
OIDIXINIAM =22 et &S H2LICL

o Disabled: (&0l == X & sUICH

e QRCodes: 25 QR 2 & L ContextCapture AHZE X & & QR 2= A2 SHESE=ge o] f
A& & LICE ContextCapture MIHE QR 2= MAHE = M4ot= O AA=2ELICH

o April Tags: AIEX HEES MH0IHU JIE M E 2 EAlot= O AF=2E LICL

e ChiliTags: AFEX EEES MMt HU JIE HHE S ZAlot= O AF2ELICH

Tts 2l nd

Blockwise, Machine learning (in tech preview) 5= None S0l Al O[O XI 0ff O © oA WIS KX
oL

ContextCapture 92 AMEL JF0/1 =



MNone

Targets extraction:

* Machine Learning (tech previ

MNone

ech preview)

Machine Learn

Blockwise

©

Automatic color correction:

Create splats:

Blockwise Z &1

U

oS

i Ats 2l 2@ S3F A skE LICH 0]

0

Lol CH

AR

Ol
il
0
oy
Kl

.y

KO

Ju

e}

ol

H &b L C
2EHA

S NAOIH TS & IHXIIt

T

=
[

0l

2. M2 SHAHUA 22 23 2= 2 "Automatic (Blockwise)" & &4,

M2 Xel

FLISDHOM 2"

FAll S

X

RO

imi

1

c
1e|l&= 0lEoto 2 0I0I KOt =

st &

Machine learning (tech preview)= 0| £

102 WHEELICL O 22 ME W ol0IXI2

2| X
=/

| OF
=

e

1

,Hal

i

[m;

cC
I

]

|
=

ol

S UEIHE HREs T AESLICH

eS
ZMAOIMH 3 & Xt

2EH

ol=

ol
0
il
o}
ulo

Ho
00

2. M2 HHUA Z2H 2SS 2= 2 "Automatic (Machine learning)" & &4,

KEA

M xel 28" FXotEAlL.

LHE0 oA Z20t="

5t

Splats

2 3D

Pjﬂ

40| MelELICh &2

2
A

Low-level settings

KD

ol

z

SCEAMNE 2= So

=
[

Low-level settings

Hog = UsL

BUHA MSE = ASLICL

off = K&

MNIE ol ZotJl

il
RO

0l

-

<0
Ho
00
E
I}
X0
20
ol
wor
il
wr
il

1t

=2
="

Aerotriangulation definition O & AF2| OF Xl 2 H O X Ol Al Submit2

Submit

LICH
Jittels £ =0 ddELICHL

£

= 5
==

2= A

= 2f X}
= o =

AFIF
=R

Mo
160
My
IS
<0

Oy

Iy
r
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AFE A} FH0]
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Cancel ‘
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Block - Block_14 - AT SubmllAernlriangulalmn“ REEESHECVEY | Remove Block H Expm‘l“ <

point(s;

4 photo(s), 0 control point(s)

General Photos Point Clouds  Surveys  Additional Data 3D view

@ Partially complete photos
The black is ready for reconstruction. You can estimate missing photo information by aerotriangulation.

Photos positioning level: relative

Warning: 1 be used

4phota(s) in 2 photogroup(s). 4.5 megapixels

3 photo(s) in the main component

3known position(s) and 3 known rotation(s)

0 control point(s) (0 full point(s). 0 horizontal point(s). 0 vertical point(s)) among which 0 check point(s)
0 user tie point(s)

394 automatic tie point(s). View

Resolution ranges from 0.0094 units to 0.01 units

Splats: available. Recreate

Aerotriangulation
This block has been edited after agrotriangulation.
Warning: Potential issue with the acquisition.

View settings | View acquisition report | View quality report

> Job Details
843 8B 42 58 F 22 HAIZEY of
HBEOIST AL SYS DE AT AXIS SIHS HAHOF BLICL 2E MRS 85 M2 SHE 21 of

14
me 10 of

. YU SO SOIN BRSPS SHS TG DMES BB M2 SYS ASSUL
. TESESASEA LD ASSINO0ISHUM M BT 42 TS AIS5I0| AE LS HABLIC
A0 Mot 2E ARI0I 52 2219 FQ 74240 SBNO2 THEHAE M22 BB 42 54S
SHHS HEE 4 USLICL NS SO, MES MO0 52 2240l LD 222 H4 &6 2l
NMEZS 83 &2 520l AFSE 4 ASLIC

2D EA

ST AL SYZDES 3D A5 BAICHHS 52 229 3D 7 BS ASELICL AR X, 51 L A0,
HEFOI3D K L HAS AIZEE & UASLIC

k=

=
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S 20N
View quality report & 215 2SI6tH &3 &2 S SH I ZAIELICL

FONUE ST A% S FQ A4 Y SHIEASLCH

W Quality repert o X

Open file | Export to PDF

QuauTY REPORT Bentley

Contents

Project Summary
G a Calibration
Photo Positions

Photo

For more information, please see our online manual: https://www.acute3d.com/QualityReportManual/en/v2.0/index.html !ﬂ

Project Summary -~

Project: Bourgst
Number of photos: 251
Ground coverage: 1.113 square kilometers

Average ground resolution: (D 34.7374 mm/pixel

seale: @ 1:104

Camera model(s): Unknown camera maodel
Processing date: 25/10/2021 153:58
Processing time: 1min 53s

Quality Overview

Dataset: @ 251 of 251 photos calibrated (100%)
Keypoints: @ Median of 16514 keypoints per image
Tie nnints: £3A4R nnints. with 3 madian of 1063 nints ner nhnto M

845 BZ &2 S ES ZIHY 0

E S 21N

L OOIHS A= HHE 2 M0 CHEt EE2E H Aot S View acquisition report @ 25 2 & LIL. O]
BINM=sS3 4L S AE D AZ oiME 2ERAE 0] O HAIotD A& AHE D 2 10F A0l 2]
SIS0 St MRAIES MBS LICHL L6 QEE AX XNE LE AAUHM ALHES= A X 200
Hst IR AE & WIS ELICH
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AcquisiTion ReporT

74 Bentley

Project Summary

Project: Beynac
Number of photos: 53
Number of calibrated photos: 30(57%)
Number of lost or disconnected photos: 23 (43%)

Paositioning:

Adjustment constraints: none
Rigid registration: photo positioning metadata

Not all photos are connected.
‘You may try to improve the result by adding more photos or user tie points that overlap between the disconnected components or isolated photos belowr.

Components

Component 1: 30 photos (30 kept in the final result)

EX RS SHGHU QRS A Ao IS HEE SMI| M IS FSHS 2018 4 USLD(ERSE
2 x)

HOIE 2 At
HOIEES AFRE [ Surveys 49| HIOIHS AR50 BE 2|2 +#51 0L QX2 A 2 ASLICH

2 Al ot
S 2L S MO U= 2
olmeeZsdE E2| 29
supportE & 4 LICh

ContextCapture

=N A BB 42 S R2ITUS USHES 28 +
2 HEAE HF0IM LHZL 2 ASLICH E
29T

97

AUsLICH

Export | Export log file for technical

AFEXF IH01=



sS8IL2¥

S AT Z2UeE 0 I EE2Z MEE = USLICL
o UM AN Z2tAEXE OlcHote A2 D UMZ RESLI

o EIAFAZEHHOA ArE0EI] ?I0H XML &£ = KML I
e ContextCaptureOl Al 3D MfH S =&ot= O AMEE =

0> H
c
HL
I
1
<4e)
g
C
O

£0 Mo

-
fw)

ScHRE0A Al

-

I ZHE Xcli= ContextCapture 2t E Ml MEIASLEH SAUSEUNA S = AUSLICH

ContextCapture Cloud Processing Console T2 X E = 22IRE XMl HE2 ol 85610] 2
MAELICH

o
e
Je
iy
o
I
==}
>

22t E ContextCapture 222 E X2l ABIA CHoll XEAISI 02 A Al 2.

BICI? 2 It L]
Import video frames LH 2t & XAHE AFE0IH HICI2 WM ZdIEE FE8 US S0 =0tg = AsLILL

BICIQOA 2 &S F=Sotci® &5 bl te s PEotL s E2 ML) 23S dEELICHL

o Starttime/end time: & & 4| Al 2 = AsLITOIZ242 2= HILURE JLE2).
e Extractaphotoevery: 822 2tA(X)SLICL Ol= S HICIL AIRANMN =2 AN =5 Z2/&LICH
e Photo output directory: ==& AL&IO| M8 &= Clei 2l LICH

MR 2t Mool QMBS BB HICI MEY AAS MATHIAIL.
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@ Import video frames x|
E Import video frames

Extract video frames and add them te the block photos.

Input video file: | C:/VIDEQS/Drone_video.mpg | l
Settings

Start time: (0,00 |5 seconds

End time: |72,94 |3 seconds

Extract a photo every: |0,330 5| seconds

b

Photo output directory: iC:NEIEDSfDrune_xridED_framesf

Imported video frames

Approximately 222 photo(s), 1 photogroup(s), 460.34 megapixels
image dimensions : 1920x1080 pixels

&) Import Close

I &/ 46: Import video frames [} 3} &/ A}

&y x2F el Hete XJE R 5L

e RE Zalee 8 el DR E AR D0 FIHELIC ContextCapture i A = S DE AlBA Sot
S SNt PY(SYE B 4 ALS)0| AHSE LD IEESLCLHICIR AIZA SO F0| L2tXl= B2
IR AR/B SHS A0 LHE B MACR HICIQES 25D 2 MAS HEXO2 IHRUAIL.
HICIQ Zalele £25t0 =t5t2i o ImportS 22 BHLICH

|20 REE AZIS 220 Photos HOIXINN HEXHOR 2AE 4 USLICH

HICIQ DHUOIA JFR @ TR0 2 4 9t JH0HI2 20| USLICHLE S 424 S22 ARG &0l AR 282
TS RHEAN 3D, EE 2 YO0 2E RH)S WY AS BRI 0IS 2B 8K 86
mmmmmwmﬁouaamawmﬁgMaﬂﬁ§£mwa@@ﬂmaggga&afag|+
JhD2H0ll =88t 402 R E 0| GO E{H O A0 8= 22, ContextCapture®l &3 &2 52 Il 28 £42
AFETHO SR 2 48 XS & USLICL HHO ZNS A LA M2l U0 NSLYD FANOR

Ol
S&e M0l et 360° BICIRE ArSE s AEELICL AN 28 =0 &2 0t 01N
CIOIEHIOIAN MEBE &= 0 SHE Z2REN HAIEE = USLICH

o= T
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AEL R X IO 20|

Import photo positions i St A XIS AIS6IH EIAE TANAM AL X L SES IMHS = ASLICH

Ol S = AtSotE EFALOIOIEI 2] OI0IKI /X /= dds &8 = ASLILL

st SFo SIAE IO NIAELICHL 2= A0 et 38 2Hd2 2 AMA0| & =2 HEEEKO0F &th=
A LICH
IHHE2O0IHM= = A8 AP E R L AL 2IXI0l CHSF 3002 R EIF ZESTEIHOF & LICH S| M 2 1 Ef
A& LICH
*< Photo_File >< Easting__ ><__ Northing__ >< Height__ ><
__Omega__ >< Phi >< Kappa___ >
f:\project\images\4655.tif 47268.5080 -517764.1880 1514.7160
-0.2352 0.2168 -2.3779
f:\project\images\4656.tif 46434.1570 -517745.9920
1513.0090 0.0662 1.1163 -2.2503
f:\project\images\4657.tif 45618.8710 -517748.2010
1516.4190 0.0227 0.6976 -1.2857
f:\project\images\4658.tif 44815.0070 -517756.2330
1520.3310 0.6212 0.1720 -0.6776
f:\project\images\4659.tif 43971.6950 -517762.4530
1519.1290 0.3699 0.2398 -1.9075
f:\project\images\4660.tif 43116.7510 -517767.1580 1518.0000
-0.4866 -0.4373 -2.8745
f:\project\images\4661.tif 42266.8970 -517754.3210 1519.9090
-0.3243 0.8787 -2.6415
f:\project\images\4662.tif 41407 .3450 -517763.1880
1525.5080 0.0320 0.2612 0.0047
f:\project\images\4663.tif 40520.2080 -517783.6610 1523.6580
0.1627 0.7922 -2.7976
SIX L S/ NE HEole EAE U299 0

il

Jthlict 2E, MHE S SH &M =HS M2 8B XML £= Excel €42 AISELICL =5 L2 E
3 A

=i 3=
Y HAE IS /BT
EFAFGIOIE DFRI D12 Al X528 /2 BIAE IS M BHLICH
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L Import positions and rotations from text file H

Import positions and rotations from text file

“mport postions and rotabens for & set of photographe. £ach photo s reprezented by & bre in 2 text file.

Ingat file | Input file

File formiat Friter the inpurt b=t file

Filz nare: | €ypheta_postions_rotetians b | |

= Hack & Mt Impart Cannel

JE&/47: Input file B/ 0/ X/

23 20l 2 =% ™ ContextCaptureOil A O I 2| 2EIX0 CHol R S === A& LICH
PRI OO H=E = 8ot0 UIOIE DIl 2I1 HIOIE2 2 E0il 20l [ 2N ESHES & +
USLICH

e Number of lines to ignore at the beginning of the file: It 2! 6l &
e Delimiters: € 2 J|ISE Z2SLILL W SXAE XNEFE

S AIRAIN A2 IS E ASE = &R = Combine consecutive delimiters S8 0| 22 & %= JASLICH

e Decimal separator: &(123.456) £ = & H(123,456) & LIC}.

ContextCapture 101 AEXF 0/ =
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Import positions and rotations from test file

Import positions and rotations from text file

“mport positions and rotabons for & set of photographs. £ach photo s reprezented by & bre in 2 text file.

Input file

File format i

[ata properties

Fieldls

S AIE LI

GOl &4

It = I0IEE

&g/}

P2 /XL A 3/ H O{OH &

ContextCapture

File format
Dxatina howw Ehe input file must be read

Humber of ires Lo ignore ol the begining of the (e lﬂ_?

Dalimtrrs Oacimal saparatar

and = 123.456 |

[Spaps " "]

[+] Combine consecutive Celiritars
File preview

S Shoto 1D =<
OREA D 20303 T
0RO J08M.TIE
OREA D 20305TF
UELA 0 20E0h. T I-
ORMA 0 _20807.TIF
ORLA 0 _20e0n T
ARTA K WENATIE
i

Easting =< _ Morthing  »< Height =< Phi»<  Omei =
GOJEO0.7E3 S170956.401 455377 26086 3.0167 193017
BUI0O0.684 6170E34.191 451828 -L2MWI -9.8313 B.O033T
691156,367 S170855.068 250,360 -2.6430 -FAGIE 55157
BUIZI0.EIE O1AUESALISE MELLS -2HI0D -2 HSSS BaAfol
693464060 GL70R06.054 447,340 -2.5985 -0.5711 &.7056
BOIE15 168 S170928.5q8 £49.800 -3.1300 12467 B.055C
ROTTRO A7T AITAALT AN 224 =|1 -44537 -7 10R4 1:!17-|

]

Column 4 Cr_\lui|

61709564061 43527
170834142 a528%
G1T0851.068 45036

: =
i | |

[ta prasdaw

Calurnn 1 Colurnn 2 Caolurmn 3
CIELA
CRIA

ORIA

BEAHQ R
BU000GE
GO3156.367

Fow 1
Fow 2
Fow 3

020K T
0 20804.TIF
0_20205.TIF

< Rack

0 Mt

Tmpart

_J&!48: File format H 0/ X/

=0 S EX ANAEES AL
102

AFEXF IH01 =



L

ZOFEFXR AIA

o - O

Import positions and rotetions from et file “

Iriport posillors and rotacens from Lext fle

Tmaart pasikons

Izt Tl=

File dermnat
Lﬂ!lwlﬂlﬂ

Fickds

&l
=

and retatioes Fa o act ef phetagrapha, Eocvpheta i epreaciee bralreine mstfie

Data propertics
Fwelime b nrygeonlonl 4l

SpEt raterans cvitar

Sueld chone rakan |Herwe cfoouzd ua ea) we diols arslos =
o ‘mpertrkaann

Aingles: Yt , Fitek, Roll =

Camerz otiesiatiors |3 right, ¥ dosn -

Andle units: Decress -

Lot

[ =t pemee e tacata oriy eer ariusl Foness inforration undanges)

<Bacc [ 4725 Irport Cance

_J&/49: Data properties H 0/ X/

A2 LI0IE S FIHHE XS ELIL

SA X QX A= HI0IEHS B2 22 B (LT B9l Fi= Yoo &9 AS)E dHBLITH
g 0 oA

38 82 HYBLICH L E A E.

Ol SES HE5tD U THUN A 5/ H0| ZatE B2 5T 543 SASLICH
BESIESE=Juis piEl (i

Angles: 2t =
dAa0Z HBE

O

e Camera orientation:

J}gé

down

I=F Omega Phi, Kappa, Yaw, Pitch, Roll & = Heading, Pitch, Roll( A& £/ 1] &5).
ES OIIUA X

ZX 3 H

S 9I5H 02 MIA O xy=

ak: Xright Y down(D1 238}), Xright Yup(AHE S UM O K==
Yright, X down Y left, X up Y right, X up Y left.

SHed
o=

A C[ Xl s LICH

At LICH

AMEE), Xleft Ydown, X left Y up, X

e Angle units: Degrees - = Radians.

ContextCapture
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=Rl
FIJHOOIH sS4 sE LI
» Setpose metadataonly: & K| 3D ZX MBI HA X 2LH SAELICL O SESIIH2 X L A0
ME ZXHEHHOIEH SENU IS 0XNIENM ZEXZFEINJU=dR EE0EE o= MEE =
USLICLII 2 SE2 N2/ L INMZ MR EX 80 I X HEHOIH BEE RS
HUlOlEst= A &LICH
prov I
= —
HNELIOIEH O o5 otE £ XS &LICH
2 ES ol A HAZoH0F & LICH
tsst9g 2 E2 L 00IH RE0 XA ZHELICLUHE S, UIOIHN 3/ X0l Z&EH UK ZF2H
JtseU0IH RE22 2 &0 MIHEIAl 25 LILH
@ Impart positions and rotations from text file “
Import positions and rotations from text file
‘mport positans and rotabons for & sct of photographs. £ach photo 1s represented by & boe in e text file.
Ingt il Fields
File format Specify columns corresponding to the imported data
Data praperties et a line for data preaeys
Fratids | Columni1  Column2 Column3  Columnd  Colu ™
Row i1 CRIA 0_20BO3TIF  GU2300783 6170956481 45527
knw?  CRIA 0_20B0LTIF  GRI000GE  G170834142 45232
Row3  ORIA D_2DEQSTIF  GRASE3I6T 6170851068 43036
Fooww (3ELA 1 A0ECG. T BEAEMEZE 6100800 ddlial
FowsS  CRIA 020807 TIF 693464060 170905084 44734 e
|« ¥
Fizkls wlection
Column Role Preview i
Column 1 |MAA = |ORIA
Column 2 |Photo reference = |(0_20803T
e 3 1 = GO
Columin A [NAA L I
Column 5 |NiA !
Phaoto referance
Column & 2 G0 w
¥
£
. Mot all reguires | Cmegz . Phuase speacily the mssing rode(s).
Phi
Kappa
Rack g Menet Impart Canrel
_1&' 50: Fields 1/ 0/ X/
2t O0IE R0l D=t SN HBH IINHL2IIE ALY &= JASLICH 8 C+S ContextCapture= 2 ES
SS9 ALMOl OHXIAIZI LD OHXI = AFRLO AR M AL S HZELICH ATHOHH @F L= 3 10 BIAIXIDt
ZHE LAFER HYS FHACES B = USLICHL
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BlocksExchange XML/XMLZ & Al S Z X6 Al 2.
e MS Excel XLS & A!: Microsoft Excel XLS I} J| =2 & &I IL|L}
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»\S_. . Split block

Sglitting a black into several sub-blodks is needed to handle imported block of aerial imagery
containing a large number of phatos (typically > 5000).

Target number of phatos

Maximum number of photos per block: | 5000

—Height interval
Rough estmate of the haight of the scene (WGES34 elipsoidal height in meters).

Minimum height: |2

Maximum height: |lm
Output blodk base sizs

The harizontal dmensions of output blacks wil be multiples of the base sire,

husizulmuu

—Epatal reference system (5R5)

Choose the SRS in which splitng must be performed. If a custom SRS is required for a later
reconstruction, it & recommended to choess it, 5o that reconstruction tles can be made to
conform exactly to blods boundaries.,

|Local East-North-Up (ENU); origin: 48.843920N 2 366060E -]

Define the splitting origin in the SRS speafied above. A custom orign may be needed to make
Iater reconstruction tiles comform exactly to block boundaries,

% o

¥: [0

mml carcel |

78/ 52: Split block [} 3! &' A}
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enempie: Fizza & provimité de Brec
Ttinéraire Historque

» Lieux

* Cal Galerie Google Earth 33
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K ContextCapture Master [ x |

M Extract block

Extract a sub-block which covers a given region.

Extract mode
'®) Extract photos that view a given region (requires complete posas)

() Extract photos whose position |s Inside a given region (using photo positions)
Region

Enter the path of a KML file defining the region to extract.
KML file: |

Rough estimate of the height of the scene inside the region (WG554
ellipsoidal height in metars).

Minimum height: 0
Maximum height: 100

Extract blodk Cancel

72/ 54: Extract block [} S} & A}

ER=RS

2

A
In

4
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8 F I == R2EE MEE == USLICH

e Extract photos that view a given region (requires complete poses)
e Extract photos whose position is inside a given region (using photo positions)

s 43
Seist == 250 et 28 S 010 Ha-2 L= SLICH
* KMLfile
FES IAS HOot=KML ITLC B2 E S ELICH
GIS &7 £ = Google EarthE A235t0 KML I} 2 £ M A& == JASLICH

¢ Height interval
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S HZEOIH M2l 2E/HE ALS EUE = JASLILOIRALER
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S /U EE FAGHY AL,

== LHE WD
0l % Block > Export > Export block

[t galo2 28 242 LHEYLICH
W Export block - O o
~  Export block
‘ Export block properties in various formats.
Output format: BlocksExchange XMLZ format w
Output file: [D:/TESTS/Block_1 - AT - exportomniz | []
Options

Spatial reference system: Not georeferenced
Rotation format: Rotation matrix w
Camera orientation: X right, ¥ down v
Export automatic tie points: No -
Export photos without lens distortion: Ho w
&) Export block Cancel

_J&! 55: Export block (] 21 & AF

HEA 29 e 2 585 d86t1, Export blockS 236t XML It = & & LICH

o BlocksExchange XML/XMLZ &4!: 23 H2|E It H LI LHE W D| /6l BentleyHl A X & &F SIH w &
& A LI C}. BlocksExchange XML/XMLZ & Al S & X6t A Al 2.
XMLZ 842 BHolE foll It &= (zip)2 FItot= XML @A 2 & &l L|C
o ATExport XML &4l XML EAICF S =2 42| J|=2 WEWHIILICH ATExport XML S Al S
RN Q.
ATExport XML A 2 EtAL AZEQIUZ LHEUW D] ol 2t= SHEstE A LICH LSOl
ContextCapture | Al &2 CHAl It H 224 H BlocksExchange XML & &2 AFZ0H OF & LICH.
AIEXF IH01=
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e Camera orientation: 2| M0fl CHet &= &S AASLICHEHE 2/ MO0l A= =0 2HAHE)

o Export automatic tie points: 7|2 WHEUWI| It =D |2 A0 Qo X2 B o It = otLE
HEWII 2 s ZeEs ZeeLChII2 g s EEs HEUWH Il 2H 2 XML I+ 0l
MEE SACEZ MR 2 EZHE AR 0ZFS SE REE = UASLITH

o Export photos without lens distortion: At&I 2 S| 2= GIOIE 0l [t H=Z X 210 ot CIEE 2|2
JPGIIY 2 HEUWELICLOIHSH AME 2PH2 LS MEE = ASLITH

r@ﬁoogleEarm - ey S R = - =

| Fichier Edition Affichage Outils  Ajouter Aide

¥ Search

exemple : pizzeria pres de New Yo

Itinéraire Historique

0002_081000_2251.tif

Compnnam. main componeant
Photogroup: 120724_Jaune_0002
Image dimensions: 8176x6132

Focal length: 150.083 mm

Position (WGS84): 48.8381°; 2.37781°
Ellipsold haight 1283.34 m

Minéraire : Vers ce lisy - A parir de ce liey

: ; e p Nacutahlg\Pans 2012 TutoWR0002 061000 2251 tif

» Lieux

¢ Cal Galerie Google Earth 3> Visite guidée

1&'56: Google Earth Off Z A& E& KML LHZLHT/S 0
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Az &1 AR AIRDY H22E 22A0H0F ot B Ats & & 2 BlockxmlOl A & Xots 2/ M2
HEE = AsLILLEE "R Holdel "l 2 42 0| & ContextCapture Cloud Console
B ™ (Update10 OIGHOIIA XI& &l XI &= LICH

O

Camera orientation:

Export automatic tie points:

Export photos without lens distortion:

Yes - Embedded in main file
Yes - In an external XML file
Yes - In an external binary file

S LHE D]
0l % Block > Export > Export surveys

HMOE, AIELHEEE L et =As et S42=2 HWEELICH

ContextCapture =& DI2Z2ME 2 S&= watolt= ol HEgeLIH(EE
2 X XNE FMst =240l %E MOHE L AIEX E&E L8).
- KMLIIZ (84 X =3 88): H&E GIS &+ £ = Google EarthOll A AtE 21 XIE Al2H3tot= Ol
Hgtet S A LICH
- HIAE MIY[0IEXYZ]
W Bxport surveys — O >

»  Export surveys

‘ Export control points, tie points and constraints.

Output file and format

Format: | ContextCapture surveys file (*.xml) “
File: |D:,-'TESTSIEID::P: 50pc - Surveys.xml | IZ'
Options

Control points
Tie points
Spatial reference system: | Local East-North-Up (ENU); origin: 46.654¢

Constraints

&9 Export Cancel

Export Surveys Ol 3t & X}
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AE 3pmMe =2 LHE LD
=21 0/0IX L MZE 20 Al 2= 3DMO|l CHEH OHZ Al S A4 A BHL|CH
Orbit3DMCZ HIOIHE HWEUWHH ZZNE SEO| Y SH= HdEHG}
S0l HAEAE HRE WAL JH D LEA O
Orbit 3DMZ S 45t & Al 2(0teH 0101 Xl & X).

v [ Roof
Aerotriangulation

Split...
Extract...
Import

New 3D reconstruction Export to Orbit 3DM...

New orthophoto/DSM

Clone

Bl Eportto Orbit 30M

. Create a Mapping Run for Orbit 3DM from block imagery and productions.
Select the items to include and click ‘Export’ to proceed.

File name: File location:

[ Orbit 30M Run (3) | [ DuTESTS! - |
Resource type: Mapping Run ~

B Imagery

&1 Mesh Reconstruction_1 - cesium with app (Cesium 3D Tiles) b

1 Paint claud Reconstruction_1 - opc (OPC) v

O orthophoto L B v

[J DEM I sept-21 pduction_1 (Gec '
Options

[ Use links to input data

3 items selected Cancel |

Export to Orbit 3DM CH 3t &F Xt

SN AHE A0 HEC = HEE = JASLICHOH 0101 X &=
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DEM Mot available

Annotations Reconstruction_1 - 53D_5 - Dales3D (InsightsS3D) ~

Options
Use links to input data

1 item selected | Cancel |

LY g¢== 860 "Export'E 220t HISELICH
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B cC Project
|| Block 1
| Block 1 - AT
Al B8 Block 1 - AT - AT
Aerotriangulation
Split...
Extract...

Import
Export

Mew reconstruction

MNew insight

Clone
Delete

Rename
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BlocksExchange XML & &1 2 BentleyJt ContextCapture Masterfil Al 22 H2/E I HU LHE LI <K
X&Est S0 wet A LICH
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A2 0l 2k AF IFE 2 ContextCapture £ X| CI2H 2|0l A &= == U&= LI Ch(doc/BlocksExchangeFormat.xml).

ContextCapture Jt0ict 2 2 0ll CHEF XAl & LHE 2 ContextCapture Jt0Ict 22 S A0 Al 2.

MS Excel =& &2

MS Excel 2 M0l A £ & 2| = BentleyOll A XIE &t A0 et MSE 5= ASLILCHL

== J|E MSExcel ZAM0IA XLS E= XLSX @ Al22 A M 2| 2ol M=E LICH
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Ct2 ContextCapture & X| Cl&E{ 2| 0l A Of

¢ doc/BlocklmportSample.xls
¢ doc/BlocklmportTemplate.xls

CIOTEN 12N E
MS Excel TH 2 0fl Al Tl OI Bl = 0121 I IAIE2 HIZELIC

O XLS 8412 16,3842 HOZ ML 22 M 2 HOIHAEE A= FR UM XLSX EAl 2
ANESHA AL,
Photogroups
S22 i il B+ Z8lol= A JIE S5
e Name: Ol AIXI &2 DR & 0IS(E =+ AHEY
e  Width, Height: = & &2| 2| O|0| Xl 2I[(E == AIE)
e FocalLength: mm 22| =& Hel(2 = At
e SensorSize £ = PixelSize: mm & 2| (2 4= AIEH
e  PrincipalPointX, PrincipalPointY: 2 & &2 Q| =& 2| X| (& & AtEh
e  PrincipaPoint]lXmm, PrincipalPointYmm: mm S22 =& 2 X|(& & AFEH
e CameraOrientation: I+0fl 2t & &F & =& (BlocksExchange XML/XMLZ S A (& &4 AFEH) & X)

e K1,K2,K3,P1,P2: &l X 2| = Hl (& EH ALED)
Photos

St Z2 e DK B == t
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AR 2=
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ﬂJIﬂJ
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e Name: I} 0| S(E =+ AMED

e PhotogroupName: HZ & IOt OIS (2 = A

e Directory: 7|2 Cl&EEH 2| (& ALED

e Extension: I} & 0| A& EH AFED

e Longitude, Latitude, Height &£ = Easting, Northing, Height: 3D | X| (& € Al&)

e Omega, Phi, Kappa & = Yaw, Pitch, Roll, & = Heading, Roll, Pitch: S & 0| (et & &9 L= 2tC| ot
CHS|O| 5| & (M &4 AFEH

0l

)

A& Name2 20 B2, 4l B2 L= I 0|5 == ASLICHL

=2
Al ALl 8 2 = S & BaselmagePath(& & A&, A&l Directory(& &4 AHE), AFEl Name & Extension (& &4
MENE2 A5 2-ELICH
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ControlPoints

HOE =8 H20ted® H4Al BlocksExchange XML/XMLZ S Al S AL oA Al 2.

Options

MS Excel It2 S ol A 6t= Ol AIE = SELIC
SRS

3D FIX L S HE W& OtE L) AIEE = Z2H & AL E/LICE

EPSG = E("EPSG:XXX"), PROJ.4 £= WKT E 2| E X & &LICH

A

InRadians

20 BRIJEOHE 2O HRAZ NS EH S X EELICH

=

0%

BaselmagePath
ME B BZ2E H4dol= 0 A2 = JI= O (88 ALY LICL
BlockType

S & (M AFBHQILICH

ATExport XML & 4!
ATExport XML & Al 0= 2 AFRIOfl CHEE LIS & 21 2 2 & GI0I1EH ot Z£atE LICH

e ImagePath: O|0| Xl I} &2

e ImageDimensions: 0| 0| Xl HH| & =0|(E4&)

e CameraModelType: FA/S/8 L= 0/0 el X

e FocalLength: =& Hel(H4)

e FisheyeFocalMatrix: It0ict 2 S & o e/ X8t AEE =
e AspectRatio: O|0|X| 2/ & HIE2

e Skew: O|0I Xl A=

e PrincipalPoint: 0| 0| X|2] =& </ X| (& &)

e Distortion: It0lict L& R & FA/SFE B AIEE = X H=
e FisheyeDistortion: It0lict 2 R & /o e/ X0 Bt AAE &=
e Rotation: AHEl 3| M (& & XA E A2 ECEFUIA HE)

e Center: AtXl 2| X (S & & X E Z<L ECEFUHIAM H3)

o Skew:x ¥y A = A0|2 2EE HOlot= A= H=

e Aspectratio: Z 0| FAIZE0| Ot 22 10| OFE
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£ ATExport XML & A2 EFAF AZEQIHZ WELHD| 218 EE 2 M & E S LICH LIS 0l ContextCapture 0l A
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@ Comers database e ] x
’ Camera database
Manage the database of camera modils.
|
I =
Filter: Ilme 'i 8 camera model(s) | vesee x
Source . Hame Diate | 4 Add...
| |E contestcapture  vexcel Imaging GmbH UiraCamp 10/1/2015519PM | S
it—' ContextCapture Viexcel Imaging GmbH URtraCamx 10/16/2017 3:57 PM .
|E! comencapture  Vexcel Imaging GebH UNraCami prire 10/1/2015 5:15 PM S
& ContextCapture wexcel Utracam Osprey Oblique 10300x7700 202872019 345 PM
& ContextCapture Wexcel Ultracam Osprey Madir 134703670 2282019 345 PM
& ContextCapture Vexcel Uliracam Eagle F&0 61572018 4:40 AM
& ContextCapture vexcel Ultracam Eagle F100 B/19/2018 4:46 AM
& ConteiCapture Vexcel Ultracam Eagle F21010 B19/2018 448 AM
! |
Salection
ok ] cance

_7&/59: Camera database [} 5} &} A}

JtoIcH CIOIE IOl A M E S IRl 72 &S0] USLICH

o ContextCapture & =2 ContextCaptureOll 4 HS3dt= 212 JtHict SLALICL Olefst &5 40|
HMEO0|IH &= === ContextCapture X & S0 A O SOOI EELICY
MNEL =2 ZHEEUA FIotHLE LE2 ItHet LELICH

2 SH0I2t RS 01 S(R2I02), SR(OIXIS +5), CHYBH(H s AE B8t 24 9 AM/01X DI EC2

“dEULCh

e 540 et TMe S22 ALY 1S5S EXotY AL,

f

W@ Comera model =

@ Camera model
Check and edit camera mode| properties.

Marme: (D31 FC350 3.61mm 4000x2250
Last modfied: 2/28/2018 5:07 PM

Optical properties

Model type: Ferspective w
Model band: Visibie -
Sensar stze (mm): |6.24

Enage dimensians (px: [4000:2250 .
Focal length: E?sm mm

Distortion: 'p.msm P1:0 P2:0 ﬁlr\ect:tru-ei example: "K1:0 K2:0 K3:0 P1:0 P2:0 Direct:true”
Frincipal poant {pe): i:_(:zom.a ¥:1093.88 example: "X:2566 Y:1551°

Azpect ratio: [1_ |

Skew! |lll
Advanced >

o] o

& 60: Camera model CH 3+ & X}
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£ 9| Photos E{0ll A At ?

AFRIOl DFEF M & I el
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2. Camera database {2t & KO A KIS = 2EHE AFE0HH A et Jtliict 22= S48 LICHL

ContextCapture

P10 2SS AEX

o
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EZ HELZ 2856t Get camera model from the databaseE &4 8L

photos... |=| |HH Import videos...| | |l Remove photos| | % Set downsan

ogroup  Status

o @ Add camera model to the database...
Import optical properties...
Export optical properties...
Ungroup
Set pose from metadata
Clear pose
Set metadata from pose
Clear pose metadata
Set mask...

5JPG

6.IPG Delete
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o Camera database n {

@ (et camera model from the database 5

Please sebect an item from the camera datshaszs,

Fitter:  [Same mage dmersors - | 1 camera madel(s) s e i Jal
Seurce . Marne Date =5 Add...
[E ComemCapture | Wexcel Imaging GmbH UttraCamy 012005 171909 = pamo

Selecton

Hame: Yexorl Tmagmg GmbH Uhralamx

Laest madified: 01)10/2015 17:19:09

Madel bvpe: Perspeclive

Sersor sp=: 103696 mm

[mage dimersions (o 9420 14430

Focal length: 100.5 mm

Ok Cancel

=

18/ 62: Camera database L2} & AF0IA! FH0CF 22 2/ 4% 0OKE 26t AHE 1S 01l & &8t It et
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o AR S AEUHAM S212| Photos & AHE: 0] HHIA REE ALE
CIOIEA B Ol A0l Al=50HH =0 == QS LICH

o SEIZZIY UIZO0IAM ContextCapture = &: il Options > Manage camera database. 0| 2&= 0| & 0fl
FOtetothlict 222 BHE =AM 22 20 =SS A0 Ar2E == USLICH

[y = [ N —
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photos... |»| |HH Import videos...| | |Ed Remove photos| | % Set downsan

ogroup  Status

s 2 Add era model to the data
Import optical properties...
Export optical properties...
Ungroup
Set pose from metadata
Clear pose
Set metadata from pose
Clear pose metadata
Set mask...

5JPG

65.JPG Delete
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Camera database CH 34+ Xt= ContextCapture & &: S
= I =AHIIE YIS HEY =AM = ASLICHL

| %+ Options > Manage camera database 0fl A 24 A A &t
USLICL Ol CHEtA XS ALS 0 M AIE R & =

O

ContextCapture & =2 HE & = s LICL

ALEXE SO 2 CIOTE Bl 0T A JEE 2 I1/UHE L |
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DM/ HEUIIIISS ABE & USLICH

APM 1S9 Jtliet 2& S0t

1. AIA OES 0IRA QLEZE HESZ 226+ 10 Add camera model to the databaseS & = & LI CF.
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Add photos... |~ ﬂ Import videos... ‘?ﬁ Remove photos i

] .
hotogroup Get camera model from the database...
itogroup 1 o i

Import optical properties...

Export optical properties...

Ungroup

Set pose from metadata

Clear pose

Set metadata from pose

Clear pose metadata

Set mask...
o
0385.JPG

Delete
0386.JPG
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m Camera model
Check and adit carmera model propecties.

Hamae: ;.Unltnwm camera 43%.1\;" 400002250

Last modified: 2/28/2019 5:34 PM

Optical propertes

Model type: Parspective w
Modil band: Visible ¥
Sensor size (mm): 6.24

Image dimensions [pd: 4000x2250

Focal length: 365132 mm

Destortion: 1.0205896 F1 10 P20 Dw_rect;]lu_-e. example: "K1:0 K2:0 K3:0 P1:0 P2:0 Direct:=true®
Principad podnt {poc): *2004.8 ¥:1093.88 example: "X:2566 ¥:1551"

Aspact ratio: 1

Skew: o

Advanced >>

3. OKE 2=t AtE Xt Jt0ict GIOIE IOl A0 Jthiict L' S FIHeLICH

P%PF$P
INE==!

stotliict 222 sLet JthictE Z2Ee M AR S =IHE [ ContextCapturefil A XIS 22
LICt Ol &= ContextCapture i M= It0ilet 22 2| OH X

Jl=s GEUh

M S2UAM=3D M L= FAAIE/DSM(S2H & X AIAE, 208 A9 B, Met =2, 2B X, Xel £8)S
ddote 2 SAIAE 2cISELICL A =00 [et 8 O = 01 H2 MES Al *2* USLICH
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e 3DMA: A I Rot= Hd0 Heet &% 3D 2 LICH
o ZAME/DSM: AHMOIA DS E HAHAHN I DSME d-ot)| 28t 8ECE the=3t= 25D 2 LI

Reconstruction - Reconstruction_1

3D, Regular planar grid (grid 300 187 tile(s), extra precision

General Spatial Framework  Geometry Constraints  Reference Model  Processing Settings

¢¥3 In production

Spatial framework and processing settings are fixed.

Regular planar grid (grid size 300 meters)
187 tile(s)

8 tile(s) completed, 0 tile(s) retouched
Extra precision

Production Format Status Progress Last submitted Processing time
production_1  Reference... @) Completed | EIEIN 12/4/2021 2:3... 2:01:54
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M2 08 s82=2 ZoELIC

o S2HTYRAE S FAIAE, 2y FA Y EHUS ZOASLICH 8 AL AHEl/DSMOI CHEH ol &f &
H3 S et

o SHAHSHZHS E20tHIIE3DHOIEE AFZS0I0 HHS MG HH LB S YXN& =~ USLICH

e HALCE2 A MEESAQN MAMHESN (et BIHCZ 22h= LES II2 A2
MESLICLO X 22 2/HX L WA XS T240l M8 0 &85 MAS0| IHMs = 2ELICH

o Mol AE2EA HUST Y Y(high, extra S)It JIEF M EF S XA ELICH

e MEA=E

&1 MZE S A&GH)| MOl Spatial framework & Processing settingsE ¥ & 6 OF & LICH M &0l Al & & ™

|I>"_

Spatial framework &2 )| 8222 MEELICL Ol B3R MHS =HSHH & H
S ERIAE 2= == USLICL

} bS8t M A

(@] I s wr O
CEELEY-SS
MA A AHERX Ot KIAE2 tOd ContextCapture Engine &£ = ContextCapture Cloud

o = =
- = (@]
MBIAOA M HEE MES AHEE &= JASLICH

Process with ContextCapture Engine
Process the job locally on your own computers.

t Process on the cloud
Process the job with ContextCapture cloud
processing service.
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stIHAUNAM O MA== dde = UAsUth 2 MA=2 st A £&3(SRS, B, 24 9, Xl

SIS AHMAE HFOUA M0 CHE DBt B S SHS HAAE = JASLICHE 390 B E).

Open directory

Import
Export

Clone

Edit name and description
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Ready for production

You can modify the spatial framework and processing settings before starting production.

Warning: the expected maximum RAM usage exceeds 16 GB. It is advised to use smaller tiles.

Regular planar grid (grid size 200 meters)
22 tile(s)

0 tile(s) completed, 0 tile{s) retouched
Extra precision

& 66: M HAI 2=

SRS
W20 A S=LICH

Production Format Status Progress Last submitted Processingti "
Production_flbx © Completed 3/12/2021 2: 0:00:15 Open

Production_s LAS " Cancelled 0%
Production_3s... 35M @ completed |IETTEIIN 3/16/2022 9:1... 0:01:00

11/27/2021 5., Unknown
Production_3s... 35M @ completed |ETTEI 3/16/2022 82... 0:12:06

Open output dire

Production_3s... 35M @ completed |IETTEIN 3/16/2022 75... 0:01:06
Production_3sm  35M @ completed |IEIEI 3/16/2022 7:4... 0:01:07
Production_16  LAS © completed [T 11/20/2021 .. 0:00:22

nd manage productions.
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S YU B3R de=s LA EsLILH 2R B2, "Open output directory"E AIE06HH WL S
S22 ANELICH
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General Spatial Framework Geometry Constraints  Reference Model

Processing Settings

e ]lo v ]ilo)

Spatial Reference System (SRS)

WGS 84/ UTM zone 29N (EP5G:32629)

Region of Interest [@:\B -
Show details
Tiling
Regular planar grid v
Tile size (matars): 140.000000
Show details
Overview
Dimensions: 472 meters x 547 meters x 51 meters
The tiling contains 16 tile(s).
Expected maximum RAM usage for a job: 11 GB
— —
=2 & A AEI(SRS)
Y BT DEHEGDNE IS, 28 I 612 DF0 o) B2+ B YF TN NEEHE HEHE
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S E X AAE et et MA dZ20A 88 = AsLICH
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t21 ™ Discard empty tiles
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A EXMA 2L EL S KML @422 L2 U (0l % Reconstruction > Tiling > Export to KML ...) =& GIS
&= Google EarthOl Al 32t ZHZ AT HRQRE = = USLICH

* Licux

k Lol Galerie Google Earth 1 | :

Bing Maps E} 2! A| A
ContextCaptureOll M= Bing Maps Et2 AIAE Ol et THAS s &= ASLICH

BingMaps 32t X A|AE S HE6HL) K& = 20l et Bing Maps ZHHEH 2t EFZ S ALE0tH A S
&L

Sab Mot £ A
Geometry constraints &{ES S0l J|Z 3D UIOIHE AHE0tH MHE Mot L A LFE LA 5= UASLICH

20 et Its HANA =30l 28 A LFI 2ls = AsLICH
S22 L= 00N M It A = ASLICH

ContextCaptureOl Al E EtAt =72 T2 = 2HE 8ot HA(CIBEHX X)) MALZ S206HX 2
AWM MH Z2ANAE XIAGH| 2AcH JIZ3DHIOIHE DAHAE =~ ASLICH
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https://msdn.microsoft.com/en-us/library/bb259689.aspx
https://msdn.microsoft.com/en-us/library/bb259689.aspx

Ganaral Spetial framawork Reconstruction constraints Refersnca 30 modal Frocassing setbngs

Mama Type Description Resohaion unis
Madel Surface constraint mported from file ‘Modeloby 00088758

Add constraint from 30 mesh...

Add & new suTace consraint defined by
a mesh file.

Delate constraint...

Remove selected constraint from The
list.

_7&/ 70: Reconstruction constraints &/

AODA=S= SUH AHMEXN S Het 2AHE 2 = ASLICL EFX 2E0/ 010l A= B2 M Met =
SSHeE BZ0 HEESULILLOI= MAMAM M & Het 2H=S Ddotd Bt =S MAAELICH
ContextCapture= UtS WA 2= E& Met ZAHSE AMEE = UASLICH

H o= KML = DGN (8o X MH202Hol &)

& ot= 0B] £= DGN It
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General Spatial Framework  Geometry Constraints  Reference Model Processing Settings

ﬂ :e:
= Top

Status Retouching

Tile_+000_+000 ) Completed ... None 12/4/2019 3
Tile_+001_+000 (&) Completed ... Geometry  12/4/2019
Tile_+002_+000 (&) Completed ... Mone 12/3/2019
Tile_+000_+001 (&) Completed ... Geometry

Tile_+001_+001 |
Tile_+002_+001 |
Tile_+003_+001 |
Tile_+000_+002 |
Tile_+001_+002 |
Tile_+002_+002 |
Tile_+003_+002 |

) Completed ... Geometry
) Completed ... None
) Completed ... Geometry
) Completed ... Mone
) Completed ... Geometry

) Completed ... None

) Completed ... Geometry

0/11 tile(s) selected

_1&/ 71: Reference model &/

X D2 THAH MEBFAOILCH MZ0| ZEE o et BRAEOZ2 A2 D, 2IHAS HZ2E 2= A2,
S$S HE20| MM =2d S HEHcZ HEEHLICH
EX U228 22T H, A EILS MEXHOZ HOHE 4= ASLICH
Ol Bt = Z&fot= A0l 22 &M 2lH X E Z&6HAI &= Unprocessed EFZ 01 = Al Completed=2 & 2HE LI L}
Pe ZH=x
3D A2 2R B0l I 2 A2 EIAE 3D 04 2 A E 10, HAL AFEI/DSM2| 22 EFY 0l TIF & A1 2| DSM
I L AHAFAR I 2 R ELICH
20| 2= | 2 EF2 0| Reference model & 0l E Al E LILCH
X Rds 2elotd ™ CHS D=0 MeHE LICH
e HXY:EMEXZDESHXEZ =HELICH
e JEIAZERIHE SStelEH: AR S22 T2 NS SOl X 2 EIYUS A Aot 2B XIELICH
e MAEH:OIZ MM HHMEEE &x 2 S 2 G HIELICH
o EI2HZYH REF
MEEH EC=EHXGU 22 LR HA2EILWAN HSol0 EIYS 60 S8 HHEIAE A2
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Xel €4

Processing settings &1 S Sofl & & H YT %

N
il

SdsHIRS A Xl €8s d8g = UsLICh

P10 M&S Al Aot &0l Xl &8 = B & o OF & LICH XI2H0l Al % &l & Processing settings 8 2 81 7|
HE2o=x MEFELICH

General  Spatial Framework  Geometry Constraints  Reference Model Processing Settings

Preset type: | Default ~ | Load preset... |

Selection of matching pairs Generic ~ | Save preset... |
Photos used for geometry Exclude thermal imagery ~
Extra precision, larger file size (tolerance of 0.5
Geometric precision Extra ~ P & ¢
oixel in inout ohotos)
Hole-filling Fill small holes only ~
Geometric simplification Standard ~ | Tolerance: pixel ~

Apply the color correction computed during

Color correction mode = Automatic (machine learning) ~ _ .
Aerotriangulation.
Untextured regions representation  Inpainting completion ~ | Untextured regions color: |E|
Texture source priority Photos first ~
Geometry resolution lImit (units) ‘ D| Clamp resolution of geometry if finer than the

soecified limit
Clamp resolution of texture if finer than the
specified limit

Texture resolution limit (units) ‘ 0 |

Low-level settings

No item defined.

_1&/ 73: Processing settings &/

OiXlol= & &5
0l DS SIS AFSOHE! IXIGHS & 88 20252 SH 22 0/0IX CIOIE HIE0I 20 2= 58
& AL

o Generic(P12a): N2 =2] 0|01 X HIOIEHMEN HEELICH

o For structured aerial flight: 2 =3t & & 0I0| X E||O|E1 NEOS HEEH, E
2| &ot &lSot) DE A 2 A& U}= MAIF UASLICH

e FocusonROL A ZZE et Y HE= =& 200 &S LILCH
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a0l AFEE AR
Photos used for geometry 12 SES ALE0HH & THAN MEBEI= LS UI0IHE 88 == ASLICHL

o Exclude thermal imagery: &€ O|0| Xl SHA SO ARl S2F0ll S20tK 22 M MetELICE 0l B2 BE0l=
Zef HEDL A= AFRIBHE &

MEELICLOl= 20l= 222 AHRIOI A2 DS & WHOFCH DI 28t LICH
» Include thermal imagery: @& 2 AIE IS8 AHE 25 AFEELICHL
e None: E&E2 HQIE ScIRSECAMESLICHYHE S0 L2 E SR EIH U= ZRUILHALE Js).
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ContextCapture= Al E THE L& ZHUA 2SHE =5 U= G LS ALMONA 3D 2E HAHE
A& LICh

01D 2ol ContextCapture¥l M= &2 ALEI2| M A
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3D 2 EIAXHOIAM LS ALK 2 AL =E X012
wWHE UHS2Z =dol= 01 &E= MeteLth

0l Color correction mode S& = Soll 1A Y E Melol= U AIEE = 2 #sst 20el&Ss HEE =

USLICH

e Standard: 2% E+0fl CHoH S X2 & 8 & J|2 113 ContextCapture AtsS & E‘I as3t LICH

o Blockwise: 2Bt8 Oz HFE 2 N2SE0 FAHSID 00K 2HH O 2 AL SE XH0IE Ml g += USLICH
Ol Xts 2Sste B S AN st es &2 =2 SO AHAMELICL O 2nelESez Qo iz
Standard $EHUHA 2RSS HM EIL 2t 2 2SS 2R 40| 2MB| °*01x' LICH

i
Ol S g435totedd &3 &2t 52 8 F 0l M Blockwise EEH ¢ S3SHE 2435 0F & LICH
e Machine Learning: 2f OI0|XIE SEXCZ 2 WHELICHL =0l 3L =2 HIOIHME L= HEDt
SEoHA 22 0l0IXI0 HESLICL O nE=22E 24 ME'OH CHSh &t 8 a2t =& SO AHlAHE LICH
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Choose output format and options for the production.
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Orthophoto Segmentation

Orthophoto segmentation detector: PROJECI’S!HELSINKIMI_Training_MikeiroofB_vB| ‘ Browse... | Download

Detect 2D Lines

[] Detect regions as 2D polygons and export them to SHP file

- Segmented mesh
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Annotations: ® 2D Segmentation () 3D Segmentation
2D Segmentation source

® Run Detector O Tmport Annotations

Path: |Q:Mnalyze,l’[]etectarsflmages,l’semanticSegmentationIPascal\.-'nczﬂlz_\.rl

Minimum number of views to vote

Browse... | Download
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General Properties 3D view

Running...

The production is running.

1/4 milestone(s) completed.
Running processing time: 8s

Monitor job queue

Format: ContextCapture 3MX

'  Details
Milestones 4 B

@) Tile_+000_+000 [Reference Model] 12/05/2022 15:57

SIIEMAN 2SO0l MSEDHE

Ot Al 2.

18%

Running Tasks 1

Export3DProduction (Tile_+000_+000 (3MX))
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General Properties 3D view

@ Failed

The production failed
0/4 milestone(s) completed.

1 error(s). View error details | Export log file for technical support

@ Error Details X

Error details for Production_7 =1 B Export Logs

| €  Input data not found
5/12/2022 3:52 PM | | Task Internal25DModel (Model [Reference Model])

Input data not found. Please check location. ("C:/DATA/AcuteProjects/SurfaceConstraint_TestProject/
_1339.jpg") [InputData_NotFound]

T8/81: B0/ 4 F0/X8 XS F LI} HIE
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Properties 880l= 712 M& &F0| LT J}SLICH

General  Propertes |

Production ID: Production_1

Fermat: DS5GB

Cutput drectory: D/ TESTS/FOM/FOM [ Productions/Production_1
Cptlions

Keep untextured regions: true

Color of untextured regions: 128 128 128

Inchade texture maps: true

Texture compression quality: 75% quality JPEG

Level of detail size: Medium

Type of level of detail: Adaptive tree
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Job queue: |‘.r':,"Job5 ~

B 1 engine(s)

EJE 0 pending job(s)

E% o running job(s)

E1E 0 failed job(s)

Open job queue directory...
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*  Process on the doud

File name: CC Fraojedt - dioud

File location: [b:ycc_Console_Projectq

Projectivise project: Reality Modeling Prod Edit

& Create doud proje
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1. =& L= M &2 General & 0l Al ShareE 2= & LI CH

ContextShare

‘Eﬂ Project\Wise ContextShare

The Bentley platform to manage and share reality data.

Tio Bocess duta assacisted with the curment ProjectWise projed,
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Eeality Mmiglmg Prog
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& 2 ProjectWise & Z H|
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3. Upload HES 2
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Share on ProjectWise ContextShare

o Upload to ProjectWise ContextShare

Name * |ContextCapture Block |

Acquisition Period  [30/10/201017:08 | to [15/11/201017:09 v] | Clear Dates |

Uploaded data will be associated with: Reality Modeling Test1

Fields marked with asterisk (*) are mandatory. L [W[s]iEI | Close
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a Production definition — O
Production definition
Define parameters of the new production.
Name Format/Options
P Choose output format and options for the production.
urpose
Format/Cptions I Format: | ContextCapture 3MX " :Epwcﬂ::;iio\utmn mesh format, optimized for exchange with Bentley
Spatial reference syst...
A
Eiem Web ready
Include proxy 3D model
Destination
Generate ContextCapture Web Viewer application
Level of detail (LOD)
Generate LOD across tiles: C)
Type: Adaptive tree
MNode size: | medium (~35 kB/node) -
Include texture maps
Color source: Visible colors ~
Texture compression: | 75% quality JPEG  ~
Maximum texture size: 2048 | pixel
Texture sharpening: |Enabled
v
< Back &) Next Submit Cancel
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Construction aggregate quarry

L orntruction sggregate quarry
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1. OBJ M Z 2| General & 0l Al Publish to Sketchfab2 2= & L|Cl.

FIUUULLIULL = FTUULLUUI_UDJ
enter your description here &

0BJ production

General  Properties 3D view

.@ Completed

The production is completed.
Processing time: 4min 3s

Open with ContextCapture Viewer | Open output directory | Publish to Sketchfab
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2. Sketchfab 22 =&t API E22 H 2| & LIC

API E2 2 Sketchfab S5 &2l 0|l € £ = Sketchfab & H 0| A & 018 = USLILCH
. i Publich to Sketchfab (] |
e Publish to Sketchfab

Sketchfab is & platform to publish, share and embed 3D madels, you can sign up for free on
sketchfah. com.

Tile.oby | 3 Ale(s) | 12M8

Model name * Mascaron Free
Description
Tegs (space-separated)

| Private modsl (PRO account only)

Fassword (oobonal)

APT token *
You can find your AFI token in your Skebchfab regstrabon confirmation emai, or in your Sketchfab setbings.

All felds marked with a = are mandatory. | € Publish | |
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4. 3DSE ZZJHE AME0tH et S BHEELITH

Bentley Descartes, Autodesk 3ds Max, Rhinoceros 3D, Autodesk Maya, Autodesk Mudbox, Autodesk
MeshMixer, MeshLab S 2 2 EtAI 221 E A0l Ef2 = B & &L CF
5. 2lEH Xl EtY 2 ContextCapture MasterZ2 Jt M &LICH

o ContextCapture Master: X 21 & & 2| Reference model & 0l Al Retouches Batch ImportS 22 & L|C}.

o TWEH =X FE 0 2t Geometry touchup & = Texture and geometry touchup HI 0| = 0l Al Add
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1. Create tile(s) for wuch up

)

4, Update tile(s)

3, Import in master

o

2. Edit tle(s) in 30 application

1. Creata ble(s) for touch up 5

—s -

5. Update tile(s)
t / \duplﬂh files
4 Import in masher

3. Edit tle(s) in 3D application

Tllqu linked

ContextCapture
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HuEzozA
HIZH AIA SIS X O/ 6HOF BHLICH

0
1 o

Spatial reference system:

2OFEXR A

22 & X AIAEN S =0l M More: Spatial reference system databaseES 226t IOl & 8l 01 A 0l
OB NI AEFLICH

Ol CIOIEAHIOI A= 4,00000 Ol AfS] B2t & X A|AEIS HICHolH LSS AP X A 20 et
ASLICH

« OISI2E AlAE: ECEF(XI T
C

SHEAYLICH

e N2EEANAE: A BHAME JIE22 o=

e SEANLEFE FTEUTM, EHI=

E& & X &< Bing Maps Al A &

o AMEXHE AMAEL:SSE AZAE

ContextCapture

= QIEHOIAE ARAE S X2 L
HEE AIAE IOIEHBIOIAN HE XAl

S=0 2N X E
AE AU

T M
00

A

AN

=2

WGS 84 { UTM zone 31N (EPSG:32631) -

£4) & 22 ENU(East-North-Up) %t

Default
Local East-Morth-Up I1y; origin: 41,572310M 2, 261570E
WES 84 f UTM zone 31N (EP5G:32631)
Recent
MTF (Paris) / France II {deprecated)
WG5S 84, orthometric height (EGM38)
RGF33 [ Lambert-33 (EPSG: 2154)
WGE534

More
Spatlal reference system dambase

18 93: ZHEXE A LE HE

A8 OIOIE |0l A

HAE HIZE 3D OIZ

FEl

ZHE (0 WGS 84 91 & /2 & &t

g5

rr

E (Lambert) @3 x5 8 )&

Z ISHEHLICE

Sl LICH
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AL

e &4

R

SHEO ZAR MA(S2 2l B RA) E ME N Z U A Spatial Reference System (SRS)S < 4ot

Meis

=

Xk A
= T

AFEXF IH01=



1 Spatial reference system database [retm]
Select a spatial reference system from the database.
You can also create your own definiion by creating new user defined system,
Filter
paris Type (AL v [cear ai fiters
Spatial Reference Systems: 31 items
Spatial Reference Systemn Definition s
MNDHG (Paris) - Mord de Guerre (Paris) EPSGA902
MTF {Paris) - Mouvelle Triangulation Francaise (Paris) EPSG:ABOT
Merd Sahara 1959 (Pans) EPSGA81S
Tanamnarive (Paris) - Tananarive 1925 (Paris) EPSG:AB10
Voirel 1875 (Paris) EPSG:4811 =
Voirgl LET9 (Paris) EPsG:4821
4 [ Projected systems
4 |ambert Conformal Conic
ATF (Paris) / Nord de Gueme EPSG:27500 —
MTF (Paris) / Centre France EP5G:27592
MTF (Paris) / Corse EPSG:27554
NTF (Paris) / Francel EP5G:27581
MTF (Paris) f France I EPSG:27582
NTF (Paris) / France II EP5G:27583
MTF (Paris) f France IV EPSG:27584
MTF (Paris) / Lambert Centre France EPSG:27562
MTF (Paris) / Larnbert Corse EPSG:27564
WITE (Baris £ | ambhect Mo Erance EPSA-2T541 s
Selection
NTF (Paris) [ Lambert zone 11 (EPSG:27572)
Type Projected systems | Lambert Conformal Conic
Diakun Nouvele Triangulation Francase (Paris)
Learn more about this spatial reference system on bitp: /v spatisire ference. org reflepsa 375 72).
[Ovanch vertical coordinate system.. ]
1&/94: GIOIE B O] A O A B2+ & [AE AE
LIEIS AR50 HIOIEHIOIA NN JIE 22 BX AAHS H2H 2D LHUS HOISHA 222
SeBLICh
EZ SEAANAHUNM= FIH0HH H=5 LEs6tct= HAIKIDF ZAIE &= JUSLICH
o ZZ ENU(East-North-Up): &2 AT ZEIEZQELICL R EE HES HEHAAL.

e Bing Maps Al AE!:12H 23 AHOI2] & A

|
o AMNSAEAAEN= 0SS Z20t ELELICHO N & X).
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g 0] 2 R&HLICH http://msdn.microsoft.com 2
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https://msdn.microsoft.com/en-us/library/bb259689.aspx

USLICH

S2SMRALEEZHESZ 20t ExportS HE40H0 PR]ITZ S M & & LICHL
WL 08 7 U1 JUNFE 335 CFANIES SN
WGS 84 / UTM zone 3N EP5G:32603
WG5 84 / UTM zone 35 = Expor this SRS I EP5G:32703
WGS 84 / UTM zone 40N EPSG:32640
WGS 84 / UTM zone 405 EPSG:32740

—1&/95:SRS &9/ LHZLH I/

SRSE LHELHH SRS H2E AR UM ZZE = ASUCL UHEUWII= THE BFEOUAM AHS X Z2 SRSE
MHAtZotE OMl= RS LICL

SR R E

N2 AL £ AMAEUHAM=E IS 2 ote &8 S =0l FX(EHE A =0)2 AASELITH
C

=010l CHet M2 2 X E S E5ted ™ Override vertical coordinate system= & & LI Ct
¥ Selection of a vertical datum (]
Clear fiter J
Vertical dotum Defeition s
Chatham lsland 1959 height EPSG:5TTL
Constanta height EP5G:3781
DHHMES height EPSG:5T84
DHHNS2 height EP5G:5783 |
DM height EPSG:5733 3
DVRIO height EPSG:5799
Danger 1950 height EP5G:3192
Douglas height EPSG:5750
Dunedin 1958 height EPSG:5T61
Dunedin-Bluff 1960 height EPSGa4458
Durres height EPSG:STTT
EGMBE4 geoid height EP5G:5798
EGMBE geoid height EPSG5TT3
EOMA 1980 height EPSG:5T87
EVRF2000 height EPSG5730
EVRF2007 height EP5G:5621
FCSVELD height EP5G:3547
FVRD9 height EPSG:5317
Fahud HD height EP5G:5T25
Fair Isle heaght EPSG:5T41
Fao 1979 height EP5G:3836
Fao height EPSG:5T51 4
[ ok || cana
7896 + X HEHN WZ
SENS SOIoHE =2 ZEAIL HE 2= M ALSTHE 2 A0l ddELICH
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& 10:  H ) (orthometric) £= B & ol =H(MSL)S X2 AMtEot= JIE 0HE CIOIE Ol HIoH EFR X =01=
= (e]

EGM96 X|20|=2 =& HMEHZ ALSotH AISXI B2 ol =H(MSL) =0/2] 2 AKX E &€& == UsLICH

A
2 X AAEES Z2HH http://www.spatialreference.org/E &2t Al 2.

PROJ.4
PROJ.4 8= AIEGHH AIE A E2 S AAE S MAY == JA5LICHO: "+proj=utm +zone=11
+datum=WGS84").

http://trac.osgeo.org/proj/wiki/GenParmsE & X3l &l Al 2.

WKT(Well Known Text)
T E A E OpenGIS WKT(Well Known Text) & A2 2 & PR T2 NAM HSE = ASLICL O IR &£ 0t
B2 E SRS B2 2 S LICHOI: "C:\projections\myProjection.prj").
PRJ(.prj) T Ol &S WKT & 2/ 9 0il:
GEOGCS["WGS 84",
DATUM[ "WGS_1984",
SPHEROID[ "WGS 84" ,6378137,298.257223563,
AUTHORITY["EPSG",7030]],
TOWGS84[0,0,0,0,0,0,0],
AUTHORITY["EPSG",6326]],
PRIMEM[ "Greenwich",@,AUTHORITY["EPSG",8901]],
UNIT["DMSH",0.0174532925199433,AUTHORITY["EPSG",9108]],
AXIS["Lat",NORTH],
AXIS["Long",EAST],
AUTHORITY[ "EPSG",4326]]

=JtOIOIE

LE U FXZALHEUHNE AR S SIS AMSEULLLOIE &€=2 AHE6H)| &0l ContextCapture & X
Cl& &2l 2l "data\gdal" of % EI e elol € XIE0 QL0 0F & LICH

HESHAMSXES =X HEHE Eotes S FX AMAEUHAME GTX A2l =E AE0tH X202
ZAteHE = JASLICH
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http://www.spatialreference.org/
http://trac.osgeo.org/proj/wiki/GenParms

A E -II AH M
—_ OO
o A FX ANLAES M = UASLICH

1. Define new user system %*%Z S ERSHO M g—?i 7._5.*35 AMAE S Al EELICH
=

L TR
+ L User defined systems
" Define new user defined system...
WTF (Paris) / France [ (EP5G:27582)
NTF (Paris) / France 1 (deprecated)

Selection

Hew user defined system
Type User defined systems
Definition

Click on Edit... to enter a definition, . Edit...

1% 97: /{///(/._9]'/ I{JA/AE—//AHA—//(/II-

2. EditE 2506t0 M S22t 3 AIAE S 2 gLICh

& Edit user defined spatial reference system |3
Enter your own definition in WET or PROD.4 format or load & projection file,

To find known definitions you can also visit www . spatiakeference org.

Display name | Load fie. .,
Definition
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| AES 2O 2 M www.spatialreference.orgS 2 206HAI Al 2.

Tool Assistant
TR0 HE KA BE s BastE By :;1(o4| EHCEMCD N CD 28 T 5)2
MNEGIEE T 2= Tool Assistant=E Sl S S T2 1A 2 & Al JIs&HLICH

° /\I—EHH'.& o|_:|

- Coo bt 2
o LTINS

-

S| IT
=D AME IS SH L H=ASS 8ol O TMAE XS 24 0l Bl A

I-HI
ko
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http://www.spatialreference.org/

MEASURE A DISTANCE

Measure distance

Measure distances between points. Click on the scene to create the points of the path to
measure. Press enter or double click to close the path. User can create additionnal measures
or modify existing ones.

Editing existing measure:

® First click on any drawn measure to selectit.
® Click and drag any of the points to move their positions.
® Click and drag any of the segments to split it. and move the new point created.

Shortcuts

Mouse: Left button | Creates a new measure point

Enter or double click | Validates the measure, and allows for new measure creation

Backspace Remove lastest point greated

Esc Reset all measures, ain to leave the tool

Measure a distance: Measure a distance between two poin @
~—~

J&5: H2l & £ E ¥/ 5FTool Assistant

ContextCapture 195 AEXF 0/ =



ContextCapture Engine2 ContextCapture2| 2 X LA LICL 0| LE2 MEA &S AZ 0| HOctRERZ
ZREUA AHELICHL AIS0HA 2= S Engine 24 =22 ME M0l et SHM U Sl HHS
BOIZAE FF A= T X, HE

=/

|0/ XI OHXI, 228t 3D M2, OH 2 EIA R OHE, BIA T OlSctA T, &M dE M4 S)
2

JPHetA AdELICH B2 Lo 2 THeker Aldh HFN 2 e
O —
Aot &S 42 2 L=3DMH Z2AMAZ FAELICHL

ContextCapture Engine= Z1cHZ X 2| & XI(GPGPU)OI Al & & A&t

GPUE 0IEE == UsLICH

AR 2 Al =52 M ContextCapture Engine Ut & 3t H Ui 2 D101 E 22 & LIChL
B CAWINDOWS\system 3 2\cmd.exe
ion 4.8.0.5407-Develop ¥

a_U
S5—Jul-31 18

L2
:45:521

duct ion

_1&/ 98: ContextCapture Engine &'

&l ™ ContextCapture Engine2 ContextCapture SettingsE Soff # &= &g & C|2H| E =4l LICHE X

Al SH

=2o —

i E T,

ContextCapture EngineS ECHH A ZES |2 otH ELICL A S 2= HY2 | R4 =200
et S 42 A8 22 UOAI0ISELICL U S A2 & S0l &0t A2 M ContextCapture

[

Enginel| CtS A& 0IA X2l= WX CHII & LICH
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. = A=
ContextCapture Engine S %= 3}
J| 2 & © 2 ContextCapture Engine2 &'& 42/ =

ZFEHIOSHAM= S S8 AL HelotEE dals

ContextCapture Engine2 S4-3ol2i ™ (IS 222 AS#EHLILCHL

AFDF
(=N

0o
0n
I

AR NR

° S = oS

CCEngine --type AT
¢ TileProduction & RasterProduction & & & &:

CCEngine --type "TileProduction
RasterProduction"

AdE = Mgt

CC_MAX_THREADS &8 H 2 & &5l ContextCapture Engine2 & &dl= X[ HE A& 2
Ho|gtLICt.

Ol i ¥ sgstZFREUMA A SUUESE ZZ20Y SHLES RAot= Ul w8 =
USLICHO: L&t ZFEH X & &2 ContextCapture Mastertil CHOH StLISI 20 R XI).
Ml Ggpu BI2e2l Mgt
JI2Foz A2 Helol AHE Jts8t 2 GPUE AHEELICH
CC_XXX_GPU_MEM 2Z H+-E A HOI] A& UM AHZ6t= GPU B 22l E HistefLICh

e USKBRIZUIOIE)Z EHT KO
e XXX= ContextCapture Ofl Cl & 0ff [T+l
Ol SESATUM HelotesottiEsg Tz )ds 2d 22 GPUNHIZCIE BES6l=UH R &
AUSLICH

ot

A
e

o OIEHN JI50| HIE S S0 /UI| 20/l ContextCapture EngineO| Microsoft 23 (A& H& 2
S SLICHL 024U VNC £ = TeamViewer2t 22 3 22| ATEJHE MEE =

e ContextCapture Engine0| & & &= S0t Windows AFEXIE ®&6IH AIZ2XIFHZEH N UK LS T
OLERI0I D50l HIZ2 L322 A8 S0 HAH0 & IH & LICH
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ContextCapture Viewer

ContextCapture Viewer = ContextCaptureo f2 B AI2s 25 LICL 0] R0 = ContextCapture2| 3MX

SAN RS AA A HOIE Y AELIAUS HEol2Z2 NS ZHY =2 22 L= 221210l AM
HICIHIOIE =ZF2|3DHIOIEHE /\| 2t 518t == QL & LICH ContextCapture Master 2t & il ContextCapture ViewerS

AESIH DS EMOUAM A SES 2ele = UASLICL ZUE Mot U AESE =& ASLICL

HE A SE Lz EERE
EANHLUE2ZEUNN RFE2 U2IES

ContextCapture Viewer= ContextCapture 2t S & &l X| 2t =& &l

=
X == ASULCHL A HES &X Z2 182 Bentley &

L Ny

= ASLICHL

ContextCapture Viewer= Windows 648| EN A AIZE %= JUSLICH

a ContextCapture Viewer

Carmera Display Tools Help

&/ 99: ContextCapture Viewer
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https://softwaredownloads.bentley.com/
https://softwaredownloads.bentley.com/

ContextCapture Viewer= 3MX, 3SM, S3C, A3D(ContextCapture Master L £ & 4!), 0BJ, FBX, PLY, 0SGB S 2|
3D é:i)/\lg ol=2 A OlﬁL| EI..

=21 T Mg

ContextCapture Viewer= O| 0| XI & 12 & U SLICHL XA &= 001Xl & A 0l = JPG, TIF, ECW, JP2, PNGIt
QLI L

.

0
A

AtAISE LH & & ContextCapture Viewer AtE A3 A E AT Al 2.

N

S gns

ContextCapture S3C Composers At&ESHH J|&ES3C S22 HESIH 3D FHE MASAL A2
FOte &= USLICH XHAISE L8 2 ContextCapture S3C ComposerE & A SH A

Ay B0l 7= AAER X @EsUCH
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ContextCapture Web V

ContextCapture Web Viewer= AFE It & Bt M0l A 2 & ContextCapture SMX 22 S £ M =~
U= A2 AT EL Y LICH

>
S
D
-

.‘

ContextCapture Web Viewer= A2 A Z3H
Ol & 7= 2= A HOIXIO A X2

DEEARMUAN HSELICL

= WebGL3D RO Z, UADS, EHEX L ANEZ0 HELICH
e = JASLICHL L8t 200 = AFS6HAl @1 WebGLS Xl & 0t=

e

ql 2l 2 (LOD), HIOIE ¥ A=Y
|SLICH

AE

ol

HH 22 & ZAIEH AHE X HelE SE0ok1) GPS

nio

tH
i
rx rlo
o
gl_l
Sy
;O
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& Constructson aggregate 5 % TSN

£ = € f [ vwwacuteid.comiquarry-cedB2alalediiez5ecTh

Construction aggregate quarry

Cormtruction sggregate quarry
Input: 1170 photographs taken with 2 Sony DSC-RXLO0M3 camers and using 2 Wovadem U- 130 drone
Ground resslution 1om / pisel, Imsged and sodel courtery of Briceet Vieyrier Mesures

See the guamy in 2 tull window

Constrection guamy «

7&/100: ContextCapture Web Viewer £ & off &/ 1/ 0/ X/ 0} Z &t & 3MX K Z=E2/ 0.

2 RO E ALE0I0 BMX A ESS B EZot=s 2ES

HT

A 3MX & i BEE & X0t

ContextCapture 201
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3MXE A0 & Jtset i+l = B &

0l 5 Tools | Convert 3MX to Scalable Mesh
Ol ERE MEGIH JIE3MX2EE AH

=
Mgt Ateh: 0l HE2 Ol Bl A ™ ol As = =
D Eet A2 EAM DI UHEMXZ2E L= R E2 ER

0

#

% Convert 3MX to Scalable Mesh

Convert ContextCapture 3MX format to Bentley Scalable Mesh format (3SM) for optimal display, analysis and editing in Bentley
design applications.

Input and output files

Input file: | |

Output file: | |

Options

Spatial reference system:

Please enter input filename

(@) Convert Cancel

HOl == 22 SMX MANAME ALSE = USLICH

e
10
i
0
ol
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ContextCapture S3C Composer

ContextCapture S3C Composer= ContextCapture Viewer | Al Al2t3IE 2|8t S3C & Al 9|

—/

o
IH

ZHE =]

HH
i

ContextCapture S3C ComposerS A& 6t ContextCapturefl M A4St J|ES3CHH IS HEGHN 3D
S HAGHAUL TS Fote == ASLILCH
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ContextCapture S3C Composer J| & CIE{ H 0] A

A EH

(D |

2 o
WX by

e UIBIANOIERXZ2HEN
. °“31|A| —?—I@S3C’é

=
=

0 ry

ContextCapture S3C Composer J| & CIE{H O A

o ContextCapture S3C Composer [Paris_samples3c'] S “
File Toels Help
E d ¢
|..“H* | Models
kiR Edit the list of models included in the scene.

RO S Datal Tile_»000_+ D00\ Tile_+ 000_+ 000.53c A || = Add model,..
Mg Drata) Tile_+D01_+ D03, Tile_+ 001 _+D00.53c
? Drata'\ Tie_+002_+ D00 Tile_+002_+000.53c 9 Remove selection

Web publishing Data’ Tile_+003_+0004 Tile_+003_+000.53<

Drata\ Tile_+00d_+000A Tile_+00d_+D00.23¢ Select al
Advanced Drata’ Tile_+005_+ 0008 Tile_+005_+000.53c

Drata\ Tile_+D06_+ 003, Tile_+006_+DD0.53c Unselect al

Data'Tile_«D00_+ D01\ Tile_+ D00 _+D01.53

ata\ Tile_+ 00D _+ ile_+000_+D0.53¢c e

Drata' Tide_+001_+ D0\ Tile_+001_+001.53¢
Drata\ Tile_+002_+001\Tile_+002_+D01.53¢
Data\ Tile_+003_+ 001\ Tile_+ 003_+ 00153 Load selection...
Data\Tile +004_+007\Tile_+004 +001.53¢
Drata' Tile_+005_+ 001\ Tile_+D05_+D01.53¢
Drata' Tile_+006_+ D0\ Tile_+006_+001.53¢

| Mot Tile LW L0 Tile o O LI odr

Save selection,..

78/ 101: ContextCapture S3C Composer 7/ & 2/ £ B 0/ A

S3CEH=2ELZ FLEELILL 2E A Ef2 S FOtot HUL HAE = AsLT
SEAIGSEEH=E BRUEMESUHA A2 S FIHE &= UASLIG
2IF OB E=FBX 22 = JUH0 L& == ASLICH

2= MSotA #2222 3D UIBIAHIOIE0l =& = ASLICHL

X
OI*AEZHE 20 M= 012l £I]1 JIsS AFE6tNH ContextCapture
(wm]

L
o= L I ZEE SZELICH

Title

M=2 F=I1e == A 201 ContextCapture Viewer 21 E{H 0| A 2] QE2Z 2|0l ZAIE LICH

ContextCapture S3C Composer J|& 21 E{H 0| A

ContextCapture 204 AEXF 0/ =



ZIE FIE == U200 ContextCapture Viewer 2/ E H 0| A 2] LEZ Ot Ol EAIZLICH
PNG L= PG Y S a3d I (SE EANZ IIHS FS3CHHE IHY S0l SAFELICH
210 X 2= 300x300E &2 MHStELICHLE 20I01K s Ase2 SAELICL

S ELTY HEIE 2P/
Model position
U AHAHE EAIELILCH

L8l Hl Ol &
HHIANOIE P L D Het 2AS AESHLICH
Minimum/Maximum height constraint
Jtiletel =0l0ll CHet Mt A S &4 35HeL L.
KN &UHE 22 =0| Me TS 2 X5k ™ Relative to ground =0| 2EE S & LICH
Maximum oblique viewing angle constraint
=X S OthIch 2eF AFOI S ZH = 0ff CHEF Mgt 2= - 3tefLCh
Navigation mode
JIE LI H 018 Z=8 LE s/

L+Z 0l ContextCapture ViewerOl Al Z &2l UIHIAHIOIE 2EE HAE == USLICH

2 HIAl
EAHO SR HHAE S ofS3C 3FHE LFEL/LL
Web server

Base URL: & A/H 2] JIZ URLE A E/&/L/CH

ContextCapture 205 AEXF I01 =



E ContextCapture 53C Composer [Paris_sample.s3c*] o “
File Tools Help

E d ¥
Models Web publishing
A — Setup the scene for a remote access bo a Web ssrver.
Coordinate system | Erable Wieb mbl=hing
Mavigation
Weh publishing | Base URL: | hittp: [frowsacute3d.com fdemos Pars
Advanced
Maxmum nurber of connectionz: 8 &
Limnit the number of simultaneous connections for one LEer secgion.
ContextCapture ViewerOll A= 0| &&= AIS0IH S3CEH0 XIZE el B2 e A HE B2E MH URLE

= oIErL| Ch
Transfer settings
L SZ +=ELICE

ContextCapture Viewer= i J| Al2t2 Z0]J| <l i Hol SAl HEE AESHH 3D EH2 A =EE

e
CI2Z2CSLICLSAI 22 =0 88 =0HE = s LUICH

2 HAISE B0 AL,

'}
=
DS e ES FARLULL

Edit command line

0+ Tools > Edit command line

o

24

e

A EE 520t Y command line2S Soff & ™ =T

ContextCapture ViewerZ 0| 2| £ 7|

| 77 Tools > Preview with ContextCapture Viewer

ContextCapture ViewerOll 4 2| ZHE 02l sLICH

instant loading scene file LI £ LH J|

Uil 77 File > Export instant loading scene file

A O
T AN

o
[
O
>
[El
Im
j_Q
o

Export instant loading scene file ContextCapture Center Edition0fl M 2t AtE &
OICIES XA AIL.
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Exporting instant loading scene file

HZEE AIE Al
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> ContextCapture S3C Composer - a
Export instant loading scene file

Create an instant loadng scene format incduding additional data and specfic motion comiraints which are suted for very large dataset
wELakzatan,

DOutput file
Ohooge the name of the new S3C soere fle 1o oeate. The output fe must be taved in the same directony as the input soene.,

Output fle: | C:TESTS WebPars_sample_opt.slc

| Display settings

Skapping lowest LODs alows to cotrmize loadng tee of relevant kevels and to avodd display of rrdevant srolificabon levels hat may affect
perception of madel quality, Warming: ignoring oo many LODs may affect display performance.

[v] Slkip lowest LODs

Lowest LOD touse: L16

Yeiormng: previous mobon constrants will be gnored iF any.
A mmirwmiam heght constraent slows o forted dose up views that may haghlght nsigmificant detads,
[+ Manimum height constramt
Height (meters): 0
Spedfic nevigation consiraints can be enabled o limit the alowed range of wewing distance and viewing angle, in order ko avoid daplaning oo
much data at a tme, and hence to ermure cptmal performance.
[+/] Mstancefangle constraimts
Minimuem scene height fo consider (meters): 0

Maimum viewang datance (meters): | 8000

&} Export instant loading scene file | Carcel

7&/103: instant loading scene file L{Z L}/

Output file

=4 Skip lowest LOD

HE0 IS I E2 22 MR EEE ZASLIT

ZIM LODE 2 FHH 2 & 2L Al2tS =/ H5tot), 22 SE A0 SSES 012 = Us 2dH 8le
cte=st 8o HAIE 2N E & AsLICL

d1: S X2 LODE RAlotH ZAl 50l = 012 = ASLICH

A LOD= & H EF2 0l A A
_00.a3d" IOl oHES). =5

Higt s st e LICH

0l
N
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o
0
x

& ol OF & LICHOI: L162 "Tile_+000_+000_L16
J

ISE AT AN MY BEE AIRS2I0 0l 868

0l
>
o
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I
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=
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o
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Minimum height constraint
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ContextCapture Target Creator

ContextCapture Target Creator= QR 2 & = 2= CH4 Chili Ef 2 April Ef 1E JIBHC 2 oI Dt =6t
tHat 2 MAH5teE & LICH ContextCaptureE Soll AFMNHM HAS UHS2Z FE0H0H S HOIEH MH 2
Asate = ASLICHL
CHaHONA Al Rl 282 SE HIOIEE ddE &= USLICH
o AMNENTEE QRIS IZIRXAMNEN=0ISU EH (M ArEHS XI &6 OF & LICH
o HMOHEQRIZZ=EH: 028t THA S 301 Ol AH0] 2XITH BHO XS DE SE0 AIZELICL AR X=
MOE2 0lE2 KNI &GO &LICH S2F&EX A|AEO U= AN HE 3D HEE HEoH AS22
N2 SESE = USLICLES HEE BHOoZ SXE £ A2H LIEH HEol s2& 0152
HMOHES AIZ26I0 28 S0 ASXOFE2E 4= USLICHL
o MBHZHQRIELH: XAt= MEt ZH2=2 AHEE LICEH Mt 224 0l= Ul JtXl | &0l ASLICH
o 2AXH:QRE =0 A& (0,002 EFELICL
o A FQRE AMOIS HelE EFELICL
o E:FIHOQRIEE WX YEE=ZES E&HELICL
e HH:FIMYAHHMQREEE etX,YE=ZES 850t M BHMQRIEE et &Y & F2
gtak2 KNI & &L
= UHH M ZAS SUS HOHUAM AIZE 200 F M2 SAISHHSH ZAHAT SUSH ZAHNA AI2E
= USLICL NS HE2 S /X XIS Mot Z2H AES EIGHYAIL.
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ContextCapture

@ ContetCapture Target Crestor = (=] ks

EpE ContextCapture Target Creator

(Op Create )i codes or Compact Targets for automanc Control Points, User Tie Points and
— Consiraints.

Targets

Target type: | QR Code -

* K Codes are machine-readable labels that contam information about the attached items.
i) ®» The codes have o be photographed at a fairly high resolution to be detectable (tag size of abaut 150
pixels).
* They are usaful for clase-range projects with user-defined labels and data.

Point Type: User Tie Foint V
Output directory: |D:/ |E|
Optiona

Name: |Pump |
Data: Model #4563

&) Create QR Code(s) | Close

211

AFEXF IH01=



ContextCapture MasterKernel SDK

ContextCapture MasterKernel SDK= ContextCapture Master2] 2E IS0 Z2 02 HAOZ M AE o
U= Python BE== L&0t=e AZEQ U HL IELLICLO EE2 MM Z2XRE MY HE L 2LIHE S

FIoH AFZ XH QIEfHIOl A CH &l 2 S8 LICH

ContextCapture MasterKernel SDKi= ContextCapture Center EditionOfl A 2F AFE & &= JUSLICHL OICI & 0ff T &t
AAlet LHEe ALEAN HCIES 20t AIL.

CMasterKernelPyE AtE0tH AIE A 2l 2 /= AH=3D M A

ContextCapture MasterKernel Python 2 & ¢! C
2SS A O Z ALE A H 2| ContextCapture SE ZZ2 142

“EA‘IIAEP Z 2 Python A EEE Sl

ML = ASLICH

SEAPI(SE Z= Y AIHHI Ol A)E AFESHH ContextCapture Master T2 M E(CCM IH2H WM AHE &l =

DEgss U = UASLIT

. OI2ME.MA HE B SHAAN I2ME E2| 22

o =2 M 2JI(Excel/XML), LHELHJI(KML, XML, cHE ©I Xl &2 ALR), 28, F5, MRI/AE D8 848 o
HEOH 2 =8 L 3D X /SI ™ Z8), MHE M8 L HEBD X L O0I0IX SE),AESHTEE 44
EIREES

e AT(ES A ZSE):PEA XN XNE 25 £3, AG ME 2 2UHE /MO, S 42 S EDAM
LHE WO

o T B2 T URI(SRS, 2 FH EHY), A Mot 22, #X SHEIEX IDMHLI/UHE WD, Z2H
ZS3h), M2l &8, el S KMLE LWEUWD|

e MEIZEMHB(EBE A, 80, HA LU HA, &S HE XL 2LHE /MO

e HAUHDLIHE

. S8 X HOOoIE &l

APIO= OIOIH wet(Hd Edl, da) & S Aot = ?let Ghdst =+

SDK & Python 2= APIO| T &t XHAISt LIS 2 ContextCapture & X| Cl 2 & 2| 2| ContextCapture SDK & H A E
BXBIAIA Q.
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MA HE2 2892 "Normal"2 & & & LICH

= Production_1

Open output directory

| setiobpriority P Urger:
Cancel High
Delete ¥ Normal

Low

Paused

AN SE = UE HEZEU 22U AISA0F ot= &2 "Urgent" &£ = "High"E & &g LICH

HENSt S LAISKIot S "Pause"SE AHSLICHE 2 &M 20 HN 2= 3).
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ContextCapture It 2t 2 &

()
==
2EE2A FE=0D 0 HEE = UH HES ES = 10| «U= 1 2» HISE LICH Bentley Systems= &
ANZet 2EHotH e SFA EST otk LM, 01 e o4SdUtEZ SH HH0l et SAE 2SS
56 010 =8HE Xl 2 & LICH Bentley Systems= 2 S2M 0 Z8HE @2 L= 2 A2 2 A0 2EE A E,
UE S5, 208 L= 2 0A &0l 0fl CHolf M= XIIl 2SLICH

NIAH2HOI0IX] 2 £E 2 CHS0ll 2o MS & LICH

x=F.D(I(0.RX-0))) +x

Aaee sy 2sLch
X HH 32 &x A~ Bl 4 o | C}.

WM EH E2 /IXIE LIEtLH=3D & HIEH Y
IS T2 UEHHE 2D 2 MEALICL RAS 245 9 0/0/X B0l 20|00, X5 2
Ol0IXIS LERE &0, Y=2 0|0/KI8 Otz gakedLIC
C=otme )20 2IXIZ LIEHU S 3D & BE I LICK
Restiet 382 UEHHE3 x 33|18 s 2, Ml 22 & X AlAEC =2 Jtnet ¢atoz Mol Jtniet
=) oHzelich. RetdsstUoMd XIS 2 ASLICH

Mpp Mgy Mgz

R=|Myp My; My,
Mag Moy Moo

A

al,
=
=

A==
Omega/Phi/Kappa 2 &:

COS@COSK COSwSINK +sinwsingcosk  sinwsSink — coswsing@ cosk
R =|—cos@sink coswcosk —sinwsingsinkx sinw cosk + coswsin@ sink

sing —sinwcos @ COS W COS ¢
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Heading/Roll/Pitch 2t &:
cosHcosR +sinHsinPsinR —sinHcosR+cosHsinPsinE —cosPsinR

R = sinHcosP cosH cos P sinP
cosHsinR —sinHsinPcosR —sinHsinR —cosHsinPcosR cosPcosR

Yaw/Pitch/Roll 2} &:
cos RcosY —sinRsinPsinY —cosRsinY —cosYsinKsinP cosPsinR
R = |cos¥sinR + cosRsinPsinY cosRcosYsinP—sinRsinY —cosRcosP
cosPsinY cosPcosY sinP

(Y,P,R)=(0,0,0)2 St M2t Y L EHREE XZ, 9 Z ZE)0A 2 B2 21 USS 20IgLIC

IE FHS AH LSO Z 3| 80otE Yaw 2 & LICH
XE F=HS A BHOH 2& 2 2 3| 8 6t= Pitch 2 = & LICH
YE =S AMH LE22Z 3| Mot= Roll ZE &I LICH
Ogstoiet gaoz Ho It 52 B 02 S22 IHRE3 x 35/ d #PALITGHEXSS
Ol0IXKIS QERE L&, YE20/0I1X2 Ot &e 252 It et 24X 2HaEh
"XRightYDown": 1 0 0
O=|0 1 0
0 01
"XLeftYDown": -1 0 07
0=(0 1 0
0o 0 -1l
"XLeftYUp": —=F 0 0
O0=(0 -1 0
0 0 1!
"XRightYUp": 1 0 0
O=|0 -1 0
0 0 -1
"XDownYRight": 0 1 07
O=|1 0 0
0 0 -1.
"XDownYLeft": 0 -1 0
0=|1 0 0
0 0 1
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"XUpYLeft": 0 -1 0

0 0 -1
"XUpYRight": 0 1 0
O=|-1 0 0
0 0 1

II:R® - R°s oz mos o eo sraol|),
M(u,v,w) = (u/w,v/w)

D:R? - R?cigoz moa gm st2oi ot
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' (1 + Kyr+Kr*+K;r®)v + 2Pyuv + P (r? + 2v%)/)
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3MX & b &

Q| =]

2 H802 MAGHE By

4 HRE YHES MAGHAH 3IMXE LHEUD| 422 MEIH OF & LICH ContextCapture Master2| Production
CHSt&XHONA O &S =3 == AS LICHOLH Ol OI X & X).

@

ContextCapture Master - [MiningSite.ccm] - 0

Production definition context

MiningSite  » Block_1 - AT Production definition

B MiningSite [Define parameters of the new productian.
Block_1
4 _ Block 1-AT |
4 Reconstruction_1 Name Format/Options

&) Production_1 Purpose Choose output format and options for the production.

= 30 multiresolution mesh format, eptimized for exchange with Bentley
ol applications.

Spatial reference...

Smm!l:lcupture 83C
Exttant OpenSceneGraph binary (0SGE)
sl ] weeb | OBJ wavefront format
. | | Autodesk FEX
Destination ' | Collada (DAE)
[T] | stereoLithagraphy (STL)
| LOD tree export
] Incluf Google Earth KML
SpacEyes3D Builder kayer
I

Masimum kexture size: 8192 | pheel

Submit new production...

] Level of detail (LOD)
Type: Adaptive tree

e and submit new
Node size: | medium (~35 kE/node) -

(] skirt:

e HNext Submit

T8 105: & Al & &4 L&

A

_I

10
ol

SMX A2 &8 AHAl 8E EA0IXIEH Ol =8HE Xl 2 SLICH3MXS = OGS Al JHXILICH

* MZ 2 ContextCapture ViewerE ALZ 5t 2¢ctQl B XL
e MicroStation1t 282 [} Z Bentley Systems M S 12 &5 284

. BIAFSEID2IEDGIS)IY A5 284
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ZAHAIS EZ=3MX MAGS SHEEX 22 20 Mot €2 S8 s8s M Ad2ulA AIESE +=
USLICH et EE0 Ot Hetst 2d =S JEoHOF &fLICH TAIE HE2 UsS MES F ot AL,
3MXO0il CHEF XHAISH LHE 2 document CI 2 E 2| 0 U= 3MX AF2F & & A (3MX Specifications.pdf) £
XA AL,
N ==
NS =20
SMXEAICZ MAS B 0t 2tH XU ZAIE O sSE8S 28 = ASLITH
#
Production definition
Define parameters of the new production.
Name Format/Options
Choose output format and options for the production.
Purpose
Format/Options l Format: [T —— | 3D multiresolution mesh format, optimized for exchange with Bentley
) ’ piure applications.
Spatial reference syst...
-~
Extent Web ready
Include proxy 3D model
Destination
Generate ContextCapture Web Viewer application
Level of detail (LOD)
Generate LOD across tiles: ()
Type: Adaptive tree
Node size: | medium (~35 kB/node) ~
Include texture maps
Color source: | Visible colors ~
Texture compression: |75% quality JPEG
Maximum texture size: 2048 pixel
Texture sharpening: Enabled
L
< Back &) Next Submit Cancel
3MXE th=et E A OS] ZE2 ECZ AEEH=s WE EA022 22 582 8 ALE0 HEGHA
ESULLBHZ AECZ HEUHHEH AZERNHE St s 2EHs ol R0 206Xl €= =%

U= EZ SE MNEIERELICL
UWEUWII sds d8e IR MAE=22 JI2 8= JH0F gLICH

1. 2 U =482 "Webready" Z2ci 1 LICL Ol Z2H1E S&46tH 4F0| & ME0l = =St LICH L8
KIZH0ll ContextCapture Web Viewer S& ZZ2 10| & & 22 & AOENM MAEESS (B)AE MEE
D2E EHIJt 22 ELICL "Webready'S A& FASIHHCIE K6t HH2S MAE 4= QX0 XA

S8 = £8ot= O =200k & LICH

ol

2. A AHAIE 2ol M2 A Al "Generate LOD across tiles" S& 0| A& ELICLOIE EH MR 2 HHUHAT

MO CASd0l ds5 e = UsLICh

3. "Generate LOD across tiles"J} 8 & & X] £ 2 & 2 "Include proxy 3D model"0| #H2| &X| 32t2 LIEL=
a2 MHELICHONH OIDIX &X). AN A28 2E6tES J|Cele S0l @401 EAELICHOI

SHE FAst I ZH0| U= G0 OFFXE HAIEX EsLICH
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! x
g (webgl/App/?scene=Marseill
webgl/App/Tscene=Marseille
[

| Marzeille
[

]

4. "Generate ContextCapture Web Viewer application" =& 2 3MX & A1 2| 3D & ™ & 0l ContextCapture Web
SEDLZNHS MLELICLMA=SS HEcte B AEANM &2 0l S8 Z2082
HelR MM 2HE ZAlol= Ol AFSELICH

It A E 0 & Bl A = "maximum texture” 37|
0I5t LICE "Include texture maps"S A& FASH 2R D0 CHSH A I HHC X FSUCHL A R
G EAHO FI|(F E£= =00)JH2048H A S = HSHX| 40Ok B LIC
AFS A

F
6. "Keep untextured regions"= M2 & A0 CHEH &S MAGHKIS OIOIXKINA HAHE SF6HA
(@)

EsLCh 8 FHA R EAY MDAl 22 850l 22 WAMELICH
7. "Level of detail" V| =2 ZH0| RUZFH 20 E S 2 SN HSLLL Ol S8 dHet B2

ChesteE HAES ZEH0I HE 2t A S0l HdSLICHL £8 S40| K RFE222 2€8
EAN 2= LICL = s €y FE2 JII1E HEHHLICHL

8. DXL, "Skirt" SE2 412 M2 THE £2 MOI0l @ E0| MIIX =S 2 e = FH L 24
Ete =80l ZHE =S LICL AHEE=3D 220 A EoHA ESUICL ==2/3DES AN AUA2M 3D
DEOHFE eeLIth

2
o

SABTORNMEC 2SS T2 A0 (Het B2 BEF AIAHS MEGHOFBILICL B2 &F AIAS
2 SE T2020M 3D AI2S Y FHE 2201 YES SLICH

Y HEI U= S FXE AAES SE46H0F & LICHLENU AlAE £ = 23 UTM/WGS 84

ContextCapture 220 AEXF 0/ =



I H 2te|E 2ol ContextCapture Web S& ZZ2 & 0= MEHE QI XHMl B2t &2 A|AEI(SRS) GIOIEHHI 0l ATt
USLICL A F O SRSHOIHHOIA=ENUAIAE L EFEPSGEYCZ HSHE M, 22 JIEES X 2lotAl
USLICLZASE SEZZNHUHMA SLOHH ZADD, LBNOZ EIANE BE 2 AFSELICH

Ol A & 21 (orthometric)E HAloted H Hghet 212F J| =& (0l: EGM96)0| = 32 HX
2= AtE06t0 3MXE & ol OF & LICH

=2 23S MEE ZR3MXMA2 & &6 MAYLICLOI ZR MA 2 & 2222 2 LICL

J|2 S3C & H SAtELICH H22| 2 E = Scene/YourProductionName.3mx IH 2] LI Ct & 30| M KIZ 20|
WebGLO| 22 2 E 3MX I} 2 2 Scene/WebGL.3mx 2/ LI Ct. 3MX 744 0fl CHEH RHAI B LI 2 3MX ALY
Lo AIL.
resource
script
[ configjson- - - - - -
App {1 & index.html
) WebGL -
. Productions Scene Data

| WebGL.3mx «==

J&'6

SHM EH=JI2 3MX A& 2SS0 Us App 2 & LICH 0] 2 0l = ContextCapture Web S £
TZ200| X5 AUSLICH App 2= M ZE Al "Generate WebGL application” S8 S & &5t Z < 0| B
HAIELICHL

App ZL0IA F=2lolfOF ot= IE 2 TSt ZsLIChL

e indexhtml I}Y: SE T2 40| RLE W ALICH

o configjson It&!: O] It 22 Scene/YourProductionName.3mx It 2 = Jt2|I| 2 =2 ContextCapture Web
ViewerOll A 2E& B = & = ASLICL

=

HU

indexhtml I}Z = & ¢ 2=E6tH S8 T2 10| EAITX EsLUICL I EA2XN0IA T 0] 2/ OfchH
OIOIXION HAIE A &2 I UHAIXIHEASLC Ol B2 2t 28 HELLICH

>_
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[ acutedd

€« - C # [ filey//C/Productions/WebGL/App/index.html

| We are sorry, but due to browsers' same eorigin_policy security restrictions. the application cannot be
| viewed by double-clicking on the file,

| There are two ways of solving this:

1. Change security for local files in a browser {access page as Tile:///example).
| 2. Run files from a local server (access page as http://localhost/example).
Please follow the instructions here: http.//www.acutedd.com/local-webgl/

—Bentley

Advancing Infrastructure

8 106: & £& ZZ 72 (indexhtml) £ F B 256/ 25 SOt RH0IA FEEHE S5 22 FFHCZ
Oloff Bt LA 0 &2 BIAI X1 I HEAIE LI
webGL A 22 22 HAIGHe H MY FE J=X M2 XA0 2L LICL3MX M2 S &0olot
Gted ® ContextCapture Desktop Viewerfl M HIE2S E = USLICL S22 Y A O Z 3MXE A EIGHH
Scene/YourProductionName.3mx I} 2 £ 0| S & LICH(OteH ATl AF &HX).
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9 Open file

@ = T b+ Plant_3MX » Scene »

Organiser = Mouveau dassier

acute3D viewer™

Acute3D Viewer - B

“ & b

Welcome to Acute3D Viewer

v G

w Favaoris Mo
I Data
% Groupe résidentiel B Plant_3mx 3mx
s Ce PC
Q’ Réseau

<

Nom du fichier : Plant_3MX.3mx

Rechercher dans : Scene F
=- [ ®
Madifié le 1

29/10/2015 1547
28/05/2015 14:05 E

ContextCapture 3MX scene (*.3mx)
|Smart3DCapture 53C model (*.53c)
|ContextCapture 3MX binary model (* 3mb)
|Smart3DCapture intérnal model (*.a3d)
|OpenSceneGraph Binary (*.osgb)

|Alias Wavefront (*.obij)

!F‘Dljgnn file format (*.ply)

| Autodesk FBX [* fix)

|Adl files (%)

w |C0me1ntamure IMX scene v

Ourir Annuler

_7&/107: ContextCapture Desktop Viewer 0 A{ 3mx I} &' &7/

o} Xl Bt ContextCapture Web ViewerS 222 S 00} ol= R HAHE NE S "E5 A: 22 Z ContextCapture
WebE2 T2 ) EI["E XA AIL.

°_||OE.LL§3 Ol Xt =

xOl_

JlE2 webGL M &20=CiS0t &

UASLICH
e IMXEACZ MHEHHES
e ER2HMUANEEHESE SEXN

.. Productions

ContextCapture

S R4ots Y

OlMNZ CHE HIOIHS MEJ S i ZE8E 0 ASH 22 EE2 ZHO

Scene = H 0l QA &LICH

clot= Ol ALS

|, WebGL
i.- N

= webGL 2=

Isi

ZSS App EH 0 ASLICH

|. resource

1. script

g configjson= == = = = =
. App { & indexhtml

. Scene . Data
of WebGL3mx «=-—-J
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X

2SS T2WAE 4K BHE HI0IES ASE 4 U202 Fols [ 3250k B LICH

3D RO{0l EAIE 21

3BDCIAZYOIIEIEAES T L 23O US MOHCH A FOH Ol EAIZ = X2l EAIX 001Xl Ol OI0IKI=
3MX & HE LEFHLICH

e Scene/YourProduction.3mx0ll Z& &1 & SHUH EAH=HHOIE XL L

o« JIZ2 UIBIAHOIE 25

4JtXl IOl = 25 Scene Z2H 0l & T O A SLICH

=0 FIt

Z 1) = ContextCapture Web ViewerOl ZAIELICH 2 15 =It6ted H Scene 2 0l Z& & 0/0| Xl logo.pngS
#Aote= 210 2 B OF 8 LI C ContextCapture Web S Z2 ]2 21 I E T HOHA 222 0|01 X
OlE2 U2 |t &2 3|2 2 DE ArE0H 0F &LICH

& ™ 0|01 Xl F=It

ZHO0I0IX=3D LIASOIItHIZ2#AESE U 2F I AUAS HOFCHZ S0l EAIELICH Ol 0101 Xl = 3MX

04
e r
o
\_l:l

t
FEFRALICH &™ OI0IXIE =I5t ™ Scene Z2H 0| L& & 0101 Xl placeholder.jpgE 2 6t= 2102
2tLICE OI0IXI2 018 & O 2 R XIoHOF & LICH.

(@)

omwmwmmW%VmwNﬂ“MﬂLmFng
a

2 il Scene/YourProduction.3mx
IMBog = UASLICLEAE HEDIHA IIZ=S SN 0IER M

H225F
FOE HiE &= UASLICH
0l € =, "YourProduction" M 20 Gt 22 JI2 2 E YourProduction.3mxJ} U & LI Ch

{

"3mxVersion": 1,

"name": " YourProduction",

"description”: "Scene generated by ContextCapture, copyright <a href='http://
www.bentley.com' target='_blank'>Bentley</a>",

"logo": "logo.png",

"sceneOptions"”: [{"navigationMode":"PAN"}],

"layers": [

{

"type": "meshPyramid",
"id": "meshe",

"name": "YourProduction",

"description”: "Model generated by ContextCapture, copyright <a href='http://
www.bentley.com' target='_blank'>Bentley</a>",

"SRS": "— given SRS —*",
"SRSOrigin": [0,0,0],
"root": "Data/YourProduction.3mxb"
}

1
}
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{
"URLs": [
{
"alias":"YourProduction",
"scene":"../Scene/YourProduction.3mx"
¥
]
¥
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{
"URLs": [
{
"alias": "Quarry",
"scene": "../DATA_3D/Quarry/Scene/Quarry.3mx"
s
{
"alias": "Marseille ",
"scene": "http://deh9aqlpmcjlj6.cloudfront.net/Marseille/Scene/Marseille.3mx"
}
1
}
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We are sorry, but due to browsers’ same origin policy security restrictions, the application cannot be
viewed by double-clicking on the file,

There are two ways of solving this

1. Change security for local files in a browser {access page as Tile:///example).

2. Run files from a local server (access page as http://localhost/example)

Please follow the instructions here: hitp.//www.acutedd.com/local-webgl/
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"Version": "2012-10-17",
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{
"Sid": "AllowPublicRead",
"Effect": "Allow",
"Principal”: {
"AWS": "E"
}s
"Action": "s3:GetObject",
"Resource": "YOUR_BucRet_ARN/*"
}
]
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, a port city in southern France, has been a crossroads of immigration and trade since its founding by the
Phoenicians in 600 B.C.E It's a place of tranquil squares and stepped streets,
[l markets. At its heart is the Vieux Port, where fishmongers sell their daily catch along the boat-lined quayside. La Canebiére,
the main thoroughfare, runs east from here.
ll You can visit this beautiful city on-line, using our accurate 3D replica.
[l The 3D reconstruction was done using our
flexible and scalable software solution to turn simple photographs into true-to-life 3D cities.

bustling 19th-century avenues and souklike

solution, probably the most powerful,
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https://en.wikipedia.org/wiki/Same-origin_policy
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L = C # [ filey//C/Productions/\WebGL/App/index.html

viewed by double-clicking on the file.

There are two ways of solving this

1. Change security for local files in a browser {access page as file:///example).
2. Run files from a local server (access page as http://localhost/example)
Please follow the instructions here: httpe//www.acute3d.com/local-webgl/

We are sorry, but due to browsers’ same origin policy securnity restnictions, the application cannot be
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meshPyramid & 2| cl010H 0= Ct= B MEJH Z&E LICH

id 4012l ID(utf-8 2 At)
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"3mxVersion": 1,
"name" :"Marseille"
"descrlptlon"'"Marsellle was generated using InterAtlas’ oblique imagery system. ",
"logo"'"lnteratlas logo.png",
"sceneOptions":[{"navigation_mode":"PAN"}],
"layers": [
{
"type":"meshPyramid",
Illdll . llmeshell
"name":"Marseille",
"description":"This is a description of the model. It should be between

quotation marks.",
"SRS": "EPSG:32631",
"SRSOrigin": [692625,4798280,0],
"root": "Data/Marseille.3mxb"
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HIH Z2HE0AM S2e gl =MZ ZAIELT

1. textureBuffer

EAX BIH JSON GIOIEH = TS 201 4 ELIC

{
"type":"textureBuffer",
"id": "texe@",
"format": "jpg",
"size":1513,

}

"d'E BIAME Y HOIA DRe HACZ AEGHA2 & Ecl 2X0M= DRoHA #&LUICH

Wmmﬂﬂlf@ﬁﬁmmﬂﬂgzg}ku&ﬂﬁﬁﬁmﬂmmﬂf3mwPmWHmmHﬂ
HIHE MEELICH B0l QIOIE 2 AJI= "size" 22 HAIE LILCH
2. geometryBuffer

& B OECOIEHE T8 2sLUICH
{

"type":"geometryBuffer",

"id": "geometryl",

"format": "ctm",

"size":835,

"bbMin": [-1243.69,-314.572,52.6138],
"bbMax": [1243.69,314.572,52.6138],
"texture": "texo"

}

d'eE EHAS I LHOIA D88t tAlo2 AEGHX St M El REWAME DRoHA Z&LILCH

"texture" Ef 1= &8 AL OIH S &0 AT I U=

AlEELICEH 912 Ol0l A & &2 "Texture buffer” & & 0f

"bbMin" & "bbMax" {2 =S HIOIE 2t SLst LA Oz HAO HIRY 8tASE AHELICH
3. textureFile
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{
"type"'"textureFlle ,
"format": "jpg",
"id": "tex1",
"file": "subfolder/SomeTexture.jpg",
}
4. geometryFile
BIAX DHE 0 OF&OEA 2 §4&F THY JSONOll = 21 2 g4 I = Jtel Il "file" BH O Z &S /s LILCH
{
"type":"geometryFile",
"format": "obj",
"id": "geometryl",
"file": "subfolder/SomeMesh.obj", "texture": "tex1"
}
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S ol 4 Ol XI(JSON & 4Y):

{
"version":1,
"nodes": [
{
"id":"node@",
"bbMin":[28.7803, -12.6859, 17.3977],
"bbMax":[30.7065, -2.68368, 28.2069],
A 2

"maxScreenDiameter":118.819,
"children": [ "Tile_p@o0_pooo_pool L20 00.3mxb"],
"resources":[ "geometryo"]

}
])
"resources": [
{
"type":"textureBuffer",
"Format"'"jpg 5
'id":"textureo",
"size":1665
})
{
"type":"geometryBuffer",
"format"'"ctm",
'id":"geometryo",
"texture":"textureo"
"bbMin":[28.7803, -12.6859, 17.3977],
"bbMax":[30.7065, -2.68368, 28.2069],
"size":1233
}
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<?xml version="1.0" encoding="utf-8"?>
<ContextScene version="3.0">
<PhotoCollection>
<Photos>
<Photo 1id="0">
<ImagePath>0:IMAGE 1059.JPG</ImagePath>
</Photo>
<Photo id="1">
<ImagePath>0:IMAGE 1060.JPG</ImagePath>
</Photo>
<Photo id="2">
<ImagePath>0:IMAGE 1061.JPG</ImagePath>
</Photo>
</Photos>
</PhotoCollection>
<References>
<Reference id="0">
<Path>Q:\DataSets\Motos\Images</Path>
</Reference>
</References>
</ContextScene>
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<?xml version="1.0" encoding="utf-8"?>
<ContextScene version="3.0">
<SpatialReferenceSystems>
<SRS id="2">
<Definition>EPSG:32629</Definition>
</SRS>
</SpatialReferenceSystems>
<PhotoCollection>
<SRSId>2</SRSId>
<Poses>
<Pose id="0">
<Center>
<x>758987.198998479</x>
<y>4066970.60510875</y>
<z>39.1859999997541</z>
</Center>
</Pose>
<Pose id="1">
<Center>
<x>758989.05099848</x>
<y>4066972.78710875</y>
<z>39.1749999979511</z>
</Center>
</Pose>
<Pose id="2">
<Center>
<x>758990.900998479</x>
<y>4066974.97210875</y>
<z>39.1619999995455</z>
</Center>
</Pose>
</Poses>
<Photos>
<Photo id="0">
<ImagePath>0:Track B-CAM2-236 2017.05.11 08.17.43(520).jpg</ImagePath>
<PoseId>0</PoseId>
</Photo>
<Photo id="1">
<ImagePath>0:Track B-CAM2-235 2017.05.11 08.17.43(242).jpg</ImagePath>
<PoseId>1</PoseId>
</Photo>
<Photo id="2">
<ImagePath>1:Track B-CAM3-234 2017.05.11 08.17.42(965).Jjpg</ImagePath>
<PoseId>2</PoseId>
</Photos>
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</PhotoCollection>
<References>
<Reference id="0">
<Path>Q:\Datasets\Railroad\planar2</Path>
</Reference>
<Reference id="1">
<Path>Q:\Datasets\Railroad\planar3</Path>
</Reference>
</References>
</ContextScene>
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<?xml version="1.0" encoding="utf-8"?>
<ContextScene version="3.0">
<PhotoCollection>
<Devices>
<Device id="0">
<Type>perspective</Type>
<Dimensions>
<width>1920</width>
<height>1080</height>
</Dimensions>
<PrincipalPoint>
<x>959.325756354222</%x>
<y>540.064799475902</y>
</PrincipalPoint>
<Focallength>1161.90449945652</FocalLength>
<RadialDistortion>
<k1>-0.130619227934255</k1>
<k2>0.11343372341057</k2>
<k3>-0.0194519247358129</k3>
</RadialDistortion>
<TangentialDistortion>
<pl>0</pl>
<p2>0</p2>
</TangentialDistortion>
<AspectRatio>1</AspectRatio>
<Skew>0</Skew>
</Device>
</Devices>
<Poses>
<Pose id="0">
<Center>
<x>-0.242398388617219</x>
<y>-1.31312823176956</y>
<z>-0.170965236298314</z>
</Center>
<Rotation>
<omega>-1.71248177918815</omega>
<phi>0</phi>
<kappa>0.000184858673830527</kappa>
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</Rotation>
</Pose>
<Pose id="1">
<Center>
<x>-0.120339121135225</%x>
<y>-1.30028905810778</y>
<z>-0.17185130833636</2z>
</Center>
<Rotation>
<omega>-1.71250988284902</omega>
<phi>-0.0117559476346202</phi>
<kappa>-0.000475042115853361</kappa>
</Rotation>
</Pose>
<Pose id="2">
<Center>
<x>0.00121763429965454</%x>
<y>-1.29989155916196</y>
<z>-0.166334627769606</z>
</Center>
<Rotation>
<omega>-1.71273910713164</omega>
<phi>-0.0528726572200851</phi>
<kappa>-0.00675225403620392</kappa>
</Rotation>
</Pose>
</Poses>
<Photos>
<Photo id="0">
<ImagePath>O:vlcsnap—Z015—07—24—O9h50m515786_;53@.jpg</ImagePath>
<DeviceId>0</DeviceId>
<PoseId>0</PoseId>
</Photo>
<Photo id="1">
<ImagePath>O:vlcsnap—zO15—O7—24—O9h51m55s4434§§§§.jpg</ImagePath>
<DeviceId>0</DeviceId>
<PoseId>1</PoseId>
</Photo>
<Photo id="2">
<ImagePath>0:vlcsnap-2015-07-24-09h52m39s752.jpg</ImagePath>
<DeviceId>0</DeviceId>
<PoselId>2</PoseId>
</Photo>
</Photos>
</PhotoCollection>
<References>
<Reference id="0">
<Path>rds:7c00e184-5913-423b-8b4c-840cebdbf616</Path>
</Reference>
</References>
</ContextScene>
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<?xml version="1.0" encoding="utf-8"?>
<ContextScene version="3.0">
<SpatialReferenceSystems>
<SRS id="0">
<Definition>EPSG:2193</Definition>
</SRS>
</SpatialReferenceSystems>
<PhotoCollection>
<SRSTId>0</SRSId>
<Devices>
<Device id="0">
<Type>orthotile</Type>
<Dimensions>
<width>3200</width>
<height>4800</height>
</Dimensions>
<PixelSize>
<Width>0.075</Width>
<Height>-0.075</Height>
</PixelSize>
<NoData>-9999</NoData>
</Device>
</Devices>
<Photos>
<Photo id="0">
<ImagePath>0:BX24 500 025022.tif</ImagePath>
<DeviceId>0</DeviceId>
<Location>
<U1X>1569040</U1lX>
<U1Y>5181360</UlY>
</Location>
</Photo>
<Photo id="1">
<ImagePath>0:Bx24 500 025021.tif</ImagePath>
<DeviceId>0</DeviceId>
<Location>
<U1X>1568800</U1lX>
<U1Y>5181360</U1Y>
</Location>
</Photo>
<Photo id="2">
<ImagePath>0:BX24 500 025020.tif</ImagePath>
<DeviceId>0</DeviceId>
<Location>
<U1X>1568560</UlX>
<U1Y>5181360</UlY>
</Location>
</Photo>
</Photos>
</PhotoCollection>
<References>
<Reference id="0">
<Path>Q:\DataSets\Christchurch\Images</Path>
</Reference>
</References>
</ContextScene>
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<SpatialReferenceSystems>

<SRS id="0">

<?xml version="1.0" encoding="utf-8"?>
<ContextScene version

<Definition>EPSG:32633</Definition>
</SRS>

</SpatialReferenceSystems>

<PhotoCollection>
<SRSId>0</SRSId>
<Devices>

<Device id="0">

<Type>orthotile</Type>
<Dimensions>
<width>2000</width>

<height>2000</height>
</Dimensions>

<Band>Visible</Band>
<PixelSize>
<Width>0.1</Width>

<Height>-0.1</Height>
</PixelSize>

<NoData>-9999</NoData>

</Device>

</Devices>

<Photos>
<Photo id="0">

<ImagePath>0:rgb part 1 2.tif</ImagePath>
<DeviceId>0</DeviceId>

<Location>

<U1X>533550.937633621</U1X>
<U1Y>5212434.93763362</ULlY>
</Location>

<DepthPath>0:dsm part 1 2.tif</DepthPath>
</Photo>
<Photo id="1">

<ImagePath>0:rgb part 1 1.tif</ImagePath>
<DeviceId>0</DeviceId>
<Location>
<U1X>533350.937633621</U1X>
<U1Y>5212434.93763362</ULlY>
</Location>

<DepthPath>0:dsm part 1 1.tif</DepthPath>
</Photo>
</Photos>

</PhotoCollection>
<References>

<Reference id="0">
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<Path>rds:7c00e184-5913-423b-8b4c-840ceb4dbf616</Path>

</Reference>
</References>
</ContextScene>

OH =~

OH | = MeshCollection 2 0 M & Z2E LICHL 3SM & 3MX A0l ® M XI&ELICH Ol

HASSRSHEE

S e

AHESZ MASHH, ContextScenes =20 THol O [{ & SRS EAICI X LSLICH OI10 S JFXl Ol Ot

UG LICH

<?xml version="1.0" encoding="utf-8"?>
<ContextScene version="3.0">
<MeshCollection>
<Meshes>
<Mesh id="0">
<Path>0:Production_1_3sm.3sm</Path>
</Mesh>
</Meshes>
</MeshCollection>
<References>
<Reference id="0">
<Path>Q:\Datasets\Bridge</Path>
</Reference>
</References>
</ContextScene>
<?xml version="1.0" encoding="utf-8"?>
<ContextScene version="3.0">
<MeshCollection>
<Meshes>
<Mesh id="0">
<Path>0:Production 1.3mx</Path>
</Mesh>
</Meshes>
</MeshCollection>
<References>
<Reference id="0">

<Path>rds:7c00e184-5913-423b-8b4c-840ceb4dbf616</Path>

</Reference>
</References>
</ContextScene>
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<?xml version="1.0" encoding="utf-8"?>
<ContextScene version="3.0">
<SpatialReferenceSystems>
<SRS id="1">
<Definition>EPSG:25829</Definition>
</SRS>
</SpatialReferenceSystems>
<PointCloudCollection>
<SRSId>1</SRSId>
<PointClouds>
<PointCloud id="0">
<Path>0:point cloud.opc</Path>
</PointCloud>
</PointClouds>
</PointCloudCollection>
<References>
<Reference id="0">
<Path>Q:\Datasets\Spain</Path>
</Reference>
</References>
</ContextScene>
<?xml version="1.0" encoding="utf-8"?>
<ContextScene version="3.0">
<SpatialReferenceSystems>
<SRS id="0">
<Definition>EPSG:25829</Definition>
</SRS>
</SpatialReferenceSystems>
<PointCloudCollection>
<SRSId>0</SRSId>
<PointClouds>
<PointCloud id="0">
<Path>0:spain.las</Path>
</PointCloud>
</PointClouds>
</PointCloudCollection>
<References>
<Reference id="0">
<Path>Q:\Datasets\Rail</Path>
</Reference>
</References>
</ContextScene>
<?xml version="1.0" encoding="utf-8"?>
<ContextScene version="3.0">
<SpatialReferenceSystems>
<SRS id="1">
<Definition>ENU:36.7127,-6.10034</Definition>
</SRS>
</SpatialReferenceSystems>
<PointCloudCollection>
<SRSId>1</SRSId>
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<PointClouds>
<PointCloud id="0">
<Path>0:PointCloud.pod</Path>
</PointCloud>
</PointClouds>
</PointCloudCollection>
<References>
<Reference id="0">
<Path>rds:7c00e184-5913-423b-8b4c-840ceb4dbf616</Path>
</Reference>
</References>
</ContextScene>
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<?xml version="1.0" encoding="utf-8"?>
<ContextScene version="3.0">
<PhotoCollection>
<Photos>
<Photo 1id="0">
<ImagePath>0:IMG 1059.JPG</ImagePath>
</Photo>
<Photo id="1">
<ImagePath>0:IMG 1060.JPG</ImagePath>
</Photo>
<Photo id="2">
<ImagePath>0:IMG 1061.JPG</ImagePath>
</Photo>
</Photos>
</PhotoCollection>
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<Annotations>

<Labels>
<Label id="3">
<Name>car</Name>
</Label>

<Label id="4">
<Name>motorcycle</Name>
</Label>
</Labels>
<Objects2D>
<ObjectsInPhoto>
<PhotoId>0</PhotoId>
<Objects>
<Object2D id="0">
<LabelInfo>
<Confidence>0.998535</Confidence>
<LabelId>3</LabelId>
</LabelInfo>
<Box2D>
<xmin>0.0319100581109524</xmin>
<ymin>0.537032723426819</ymin>
<xmax>0.374318599700928</xmax>
<ymax>0.66499537229538</ymax>
</Box2D>
</Object2D>
<Object2D id="1">
<LabelInfo>
<Confidence>0.9965625</Confidence>
<LabelId>3</LabelId>
</LabelInfo>
<Box2D>
<xmin>0.877565920352936</xmin>
<ymin>0.4940065741539</ymin>
<xmax>1</xmax>
<ymax>0.62068098783493</ymax>
</Box2D>
</Object2D>
</Objects>
</ObjectsInPhoto>
<ObjectsInPhoto>
<PhotoId>1</PhotoId>
<Objects>
<Object2D id="0">
<LabelInfo>
<Confidence>0.9978036</Confidence>
<LabelId>3</LabelId>
</LabelInfo>
<Box2D>
<xmin>0</xmin>
<ymin>0.506300926208496</ymin>
<xmax>0.29727840423584</xmax>
<ymax>0.642435193061829</ymax>
</Box2D>
</Object2D>
<Object2D id="1">
<LabelInfo>
<Confidence>0.9839146</Confidence>
<LabelId>4</LabelId>
</LabelInfo>
<Box2D>
<xmin>0.854629874229431</xmin>
<ymin>0.483299434185028</ymin>
<xmax>0.938638925552368</xmax>
<ymax>0.547508895397186</ymax>
</Box2D>
</Object2D>
</Objects>
</ObjectsInPhoto>
<ObjectsInPhoto>
<PhotoId>2</PhotoId>
<Objects>
<Object2D id="0">
<LabelInfo>
<Confidence>0.9977607</Confidence>
<LabelId>3</LabelId>
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</LabelInfo>
<Box2D>
<xmin>0.00155594770330936</xmin>
<ymin>0.516191422939301</ymin>
<xmax>0.274634718894958</xmax>
<ymax>0.636547446250916</ymax>
</Box2D>
</Object2D>
</Objects>
</ObjectsInPhoto>
</Objects2D>
</Annotations>
<References>
<Reference id="0">
<Path>Q:\Datasets\Motos</Path>
</Reference>
</References>
</ContextScene>
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<?xml version="1.0" encoding="utf-8"?>
<ContextScene version="3.0">
<PhotoCollection>
<Photos>
<Photo id="0">
<ImagePath>0:IMG 1059.JPG</ImagePath>
</Photo>
<Photo id="1">
<ImagePath>0:IMG 1060.JPG</ImagePath>
</Photo>
<Photo id="2">
<ImagePath>0:IMG 1061.JPG</ImagePath>
</Photo>
</Photos>
</PhotoCollection>
<Annotations>
<Labels>
<Label id="0">
<Name>background</Name>
</Label>
<Label id="2">
<Name>bicycle</Name>

</Label>

<Label id="6">
<Name>bus</Name>

</Label>

<Label id="7">
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<Name>car</Name>
</Label>
</Labels>
<Segmentation2D>
<PhotoSegmentation>
<PhotoId>0</PhotoId>
<Path>Segmentation2D/0.png</Path>
</PhotoSegmentation>
<PhotoSegmentation>
<PhotoId>1</PhotoId>
<Path>Segmentation2D/1.png</Path>
</PhotoSegmentation>
<PhotoSegmentation>
<PhotoId>2</PhotoId>
<Path>Segmentation2D/2.png</Path>
</PhotoSegmentation>
</Segmentation2D>
</Annotations>
<References>
<Reference id="0">
<Path>rds:7c00e184-5913-423b-8b4c-840cebdbf616</Path>
</Reference>
</References>
</ContextScene>
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<?xml version="1.0" encoding="utf-8"?>
<ContextScene version="3.0">
<SpatialReferenceSystems>
<SRS id="0">
<Definition>EPSG:2193</Definition>
</SRS>
</SpatialReferenceSystems>
<PhotoCollection>
<SRSIdA>0</SRSId>
<Devices>
<Device id="0">
<Type>orthotile</Type>
<Dimensions>
<width>3200</width>
<height>4800</height>
</Dimensions>
<Band>Visible</Band>
<PixelSize>
<Width>0.075</Width>
<Height>-0.075</Height>
</PixelSize>
<NoData>-9999</NoData>
</Device>
</Devices>
<Photos>
<Photo id="0">
<ImagePath>0:BX24 500 025022.tif</ImagePath>
<DeviceId>0</DeviceId>
<Location>
<U1X>1569040</UlX>
<U1Y>5181360</UlY>
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</Location>
</Photo>
<Photo id="1">
<ImagePath>0:BX24 500 025021.tif</ImagePath>
<DeviceId>0</DeviceId>
<Location>
<U1X>1568800</U1X>
<U1Y>5181360</UlY>
</Location>
</Photo>
</Photos>
</PhotoCollection>
<Annotations>
<Labels>
<Label id="0">
<Name>background</Name>
</Label>
<Label id="1">
<Name>building</Name>
</Label>
<Label id="2">
<Name>car</Name>
</Label>
</Labels>
<Segmentation2D>
<PhotoSegmentation>
<PhotoId>0</PhotoId>
<Path>Bx24 500 025022 mask .png</Path>
</PhotoSegmentation>
<PhotoSegmentation>
<PhotoId>1</PhotoId>
<Path>BxX24 500 025021 mask .png</Path>
</PhotoSegmentation>
</Segmentation2D>
</Annotations>
<References>
<Reference id="0">
<Path>Q:\Datasets\Christchurch</Path>
</Reference>
</References>
</ContextScene>
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<?xml version="1.0" encoding="utf-8"?>
<ContextScene version="3.0">
<SpatialReferenceSystems>
<SRS id="0">
<Definition>ENU:36.71339,-6.10019</Definition>
</SRS>
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</SpatialReferenceSystems>

<Annotations>
<SRSIdA>0</SRSId>
<Labels>

<Label 1id="30">
<Name>light signal</Name>
</Label>
<Label id="29">
<Name>pole</Name>
</Label>
<Label id="28">
<Name>manhole</Name>
</Label>

</Labels>
<Objects3D>

<Object3D id="0">
<LabelInfo>
<LabelId>28</LabelId>
</LabelInfo>
<RotatedBox3D>
<Box3D>

<xmin>-18.2450134852094</xmin>
<ymin>-33.4309299351174</ymin>
<zmin>35.994338294097</zmin>
<xmax>-17.6879619720465</xmax>
<ymax>-32.9339199858639</ymax>
<zmax>36.0384178477738</zmax>

</Box3D>
<Rotation>

<M _00>0.923586176565216</M 00>
<M 01>-0.38339088989913</M 01>
<M_02>0</M 02>
<M_10>0.38339088989913</M 10>
<M 11>0.923586176565216</M 11>
<M _12>0</M 12>
<M 20>0</M_20>
<M 21>0</M 21>
<M 22>1</M 22>

</Rotation>
</RotatedBox3D>

</Object3D>
<Object3D id="9">

<LabelInfo>
<LabelId>29</LabelId>
</LabelInfo>
<RotatedBox3D>
<Box3D>

<xmin>20.9584511724897</xmin>
<ymin>12.319399747568</ymin>
<zmin>36.1015345364395</zmin>
<xmax>21.169238198679</xmax>
<ymax>12.4793676344069</ymax>
<zmax>36.9024438572005</zmax>

</Box3D>
<Rotation>

<M_00>-0.308218298834533</M_00>
<M_01>0.951315657530951</M_01>
<M_02>0</M_02>
<M_10>-0.951315657530951</M_10>
<M_11>-0.308218298834533</M_11>

<M_12>0</M 12>

<M 20>0</M 20>

<M 21>0</M 21>

<M 22>1</M 22>
</Rotation>
</RotatedBox3D>

</Object3D>
<Object3D id="17">

ContextCapture

<LabelInfo>
<LabelId>30</LabelId>
</LabelInfo>
<RotatedBox3D>
<Box3D>

<xmin>-14.2911021167082</xmin>
<ymin>-12.3380719723964</ymin>
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<zmin>36.6555384788507</zmin>
<xmax>-12.9469008563212</xmax>
<ymax>-11.719230718431</ymax>
<zmax>40.9274766268461</zmax>

</Box3D>

<Rotation>
<M _00>-0.635254915386682</M_00>
<M _01>0.772302526525104</M 01>
<M _02>0</M 02>
<M 10>-0.772302526525104</M 10>
<M_11> 0. 635254915386682</M_11>
<M_12>0</M 12>
<M _20>0</M 20>
<M 21>0</M 21>
<M 22>1</M 22>

</Rotation>

</RotatedBox3D>
</Object3D>
</Objects3D>
</Annotations>
</ContextScene>
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<?xml version="1.0" encoding="utf-8"?>
<ContextScene version="3.0">
<SpatialReferenceSystems>
<SRS id="0">
<Definition>ENU:49.14651925,-122.8868741</Definition>
</SRS>
<SRS id="1">
<Definition>EPSG:26910</Definition>
</SRS>
</SpatialReferenceSystems>
<Annotations>
<SRSId>0</SRSId>
<Labels>
<Label id="2">
<Name>ground</Name>
</Label>
<Label id="5">
<Name>high vegetation</Name>

</Label>
<Label id="14">
<Name>power line</Name>
</Label>
<Label id="20">
<Name>bridge</Name>
</Label>

ContextCapture 272

v Generated Tie Points

“ Annotations iy
Types 30 sapmentatian [
Classes; Al w

Al
PontSite | mona

= Wl grounc

A B high vegetetion
> puint Oio[E3 I ract

=] s

e ling
Survey Paints.

Griclidxis k-
HLOIE ZURCUHAM B HIOIE 8 ME MEGt= A/HE ZE20IdH EQIE Z2REE £22
TEOIO PLYEI2Z 2 MEESLICL A EES S HIOIS0H 2E8E 2SIt l=16HIE @2 0 220/E€ELICH
2t 65535= 2D T M2 20| dIOIE22 X E & += Sl F0l Ol 2= LICHLPLY It 2 £ & ContextScene
o 2ol M&ELICE 0l 8 ContextScenes= LIS H &2 XIS LICH &t 22 UIOIEHE CAl 24 & [
T2 MAMS LN /o 3D = 1S ZUE MESLICLFH L2 A L EHOZ HF LOE
2212C &AIZ AF2E LICHLAS, POD, OPC S).

AFEXF IH01 =


https://qa-developer.bentley.com/apis/realitydataanalysis/rda-cs/#3d-segmentation
https://qa-developer.bentley.com/apis/realitydataanalysis/rda-cs/#3d-segmentation

<Label id="6">
<Name>roof</Name>
</Label>
</Labels>
<Segmentation3D>
<Tiles>
<Tile id="0">
<Path>Segmentation3D/chunk 0.ply</Path>
<BoundingBox>
<xmin>-250.491095842922</xmin>
<ymin>-249.9415383003</ymin>
<zmin>90.6222619490663</zmin>
<xmax>-105.678507545069</xmax>
<ymax>-134.42104353207</ymax>
<zmax>110.784205847665</zmax>
</BoundingBox>
</Tile>
<Tile id="1">
<Path>Segmentation3D/chunk 1.ply</Path>
<BoundingBox>
<xmin>-250.305457114898</xmin>
<ymin>-134.421020381375</ymin>
<zmin>90.5964914399069</zmin>
<xmax>-178.217349509926</xmax>
<ymax>-10.6211155119073</ymax>
<zmax>118.655770300872</zmax>
</BoundingBox>
</Tile>
</Tiles>
</Segmentation3D>
</Annotations>
</ContextScene>
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<?xml version="1.0" encoding="utf-8"?>
<ContextScene version="3.0">
<SpatialReferenceSystems>
<SRS id="0">
<Definition>EPSG:32615</Definition>
</SRS>
</SpatialReferenceSystems>
<Annotations>
<SRSId>0</SRSId>
<Labels>
<Label id="0">
<Name>background</Name>
</Label>
<Label id="1">
<Name>crack</Name>
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</Label>
</Labels>
<Lines2D>
<Line2D id="0">
<LabelInfo>
<LabelId>1</LabelId>
</LabelInfo>
<Vertices>
<Vertex id="0">
<Position>
<x>479868.86</x>
<y>4980803.44157715</y>
</Position>
<Diameter>0.0202617157732701</Diameter>
</Vertex>
<Vertex id="1">
<Position>
<x>479868.712150948</x>
<y>4980803.47680339</y>
</Position>
<Diameter>0.0664043075900635</Diameter>
</Vertex>
<Vertex id="2">
<Position>
<x>479868.341404493</x>
<y>4980803.67640449</y>
</Position>
<Diameter>0.0686980153798615</Diameter>
</Vertex>
<Vertex id="3">
<Position>
<x>479868.468095477</x>
<y>4980803.63543635</y>
</Position>
<Diameter>0.0762712781246574</Diameter>
</Vertex>
</Vertices>
<Segments>
<Segment>
<VertexIdl>0</VertexIdl>
<VertexId2>1</VertexId2>
</Segment>
<Segment>
<VertexIdl>1</VertexIdl>
<VertexId2>3</VertexId2>
</Segment>
<Segment>
<VertexIdl>2</VertexIdl>
<VertexId2>3</VertexId2>
</Segment>
</Segments>
</Line2D>
<Line2D id="1">
<LabelInfo>
<LabelId>1</LabelId>
</LabelInfo>
<Vertices>
<Vertex id="0">
<Position>
<x>479874.427917961</x>
<y>4980802.47</y>
</Position>
<Diameter>0.0185410197570828</Diameter>
</Vertex>
<Vertex id="1">
<Position>
<x>479874.28053349< /x>
<y>4980802.75</y>
</Position>
<Diameter>0.0339112355266864</Diameter>
</Vertex>
<Vertex id="2">
<Position>
<x>479874.373927691</x>
<y>4980802.67226102</y>
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</Position>
<Diameter>0.0978553816042589</Diameter>

</Vertex>
<Vertex id="3">
<Position>

<x>479874.485410865</x>
<y>4980802.89236351</y>
</Position>
<Diameter>0.0908217292202603</Diameter>
</Vertex>
<Vertex id="4">
<Position>
<x>479874.37</x>
<y>4980802.64363961</y>
</Position>
<Diameter>0.0899999999783128</Diameter>
</Vertex>
<Vertex id="5">
<Position>
<x>479874.418415482</x>
<y>4980802.71591548</y>
</Position>
<Diameter>0.0813172786177372</Diameter>
</Vertex>
<Vertex id="6">
<Position>
<x>479874.83328093</x>
<y>4980803.53223969</y>
</Position>
<Diameter>0.0816060783607562</Diameter>
</Vertex>
<Vertex id="7">
<Position>
<x>479874.612768291</x>
<y>4980803.11426725</y>
</Position>
<Diameter>0.086105905882709</Diameter>
</Vertex>
<Vertex id="8">
<Position>
<x>479874.677758315</x>
<y>4980803.21801663</y>
</Position>
<Diameter>0.0872066516702332</Diameter>
</Vertex>
<Vertex id="9">
<Position>
<x>479874.55828698</x>
<y>4980802.99093257</y>
</Position>
<Diameter>0.0900163930024753</Diameter>
</Vertex>
<Vertex id="10">
<Position>
<x>479874.755737061</x>
<y>4980803.36709735</y>
</Position>
<Diameter>0.0900001483887829</Diameter>
</Vertex>
<Vertex id="11">
<Position>
<x>479874.456513669</x>
<y>4980802.78786825</y>
</Position>
<Diameter>0.0969726626446287</Diameter>
</Vertex>
</Vertices>
<Segments>
<Segment>
<VertexIdl>0</VertexIdl>
<VertexId2>4</VertexId2>
</Segment>
<Segment>
<VertexIdl>1</VertexIdl>
<VertexId2>2</VertexId2>

275

AFEXF IH01 =



</Segment>

<Segment>
<VertexIdl>2</VertexIdl>
<VertexId2>5</VertexId2>

</Segment>

<Segment>
<VertexIdl>2</VertexIdl>
<VertexId2>4</VertexId2>

</Segment>

<Segment>
<VertexIdl>3</VertexIdl>
<VertexId2>9</VertexId2>

</Segment>

<Segment>
<VertexIdl>3</VertexIdl>
<VertexId2>11</VertexId2>

</Segment>

<Segment>
<VertexIdl>5</VertexIdl>
<VertexId2>11</VertexId2>

</Segment>

<Segment>
<VertexIdl>6</VertexIdl>
<VertexId2>10</VertexId2>

</Segment>

<Segment>
<VertexIdl>7</VertexIdl>
<VertexId2>9</VertexId2>

</Segment>

<Segment>
<VertexIdl>7</VertexIdl>
<VertexId2>8</VertexId2>

</Segment>

</Segments>
</Line2D>
</Lines2D>
</Annotations>
</ContextScene>
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<?xml version="1.0" encoding="utf-8"?>
<ContextScene version="3.0">
<Annotations>
<Labels>
<Label id="1">
<Name>rail</Name>
</Label>
</Labels>
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<Lines3D>
<Line3D id="1">

<LabelInfo>
<LabelId>1</LabelId>
</LabelInfo>
<Vertices>
<Vertex id="0">
<Position>

<x>3.27669495408764</x>
<y>-2.38028278379669</y>
<z>8.22511614762969</z>
</Position>
<Diameter>0.210008906878983</Diameter>
</Vertex>
<Vertex id="1">
<Position>
<x>3.22462717369163</x>
<y>-1.66835993119419</y>
<z>7.77181408678633</z>
</Position>
<Diameter>0.0646228165693428</Diameter>
</Vertex>
<Vertex id="2">
<Position>
<x>3.25055948322766</x>
<y>-2.50779389081678</y>
<z>8.30674826296262</z>
</Position>
<Diameter>0.187586254181419</Diameter>
</Vertex>
<Vertex id="3">
<Position>
<x>3.24724600068194</x>
<y>-2.45077881319647</y>
<z>8.27142235557896</z>
</Position>
<Diameter>0.131823435832277</Diameter>
</Vertex>
</Vertices>
<Segments>
<Segment>
<VertexIdl>0</VertexIdl>
<VertexId2>3</VertexId2>
</Segment>
<Segment>
<VertexIdl>0</VertexIdl>
<VertexId2>1</VertexId2>
</Segment>
<Segment>
<VertexIdl>0</VertexIdl>
<VertexId2>2</VertexId2>
</Segment>
</Segments>
</Line3D>
</Lines3D>
</Annotations>
</ContextScene>
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